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Throughout this manual, trademarked names might be used. We state herein that we are using the names to the benefit of the 
trademark owner, with no intention of infringement.

Disclaimer
The information and specifications described in this guide are subject to change without notice.

Latest Version
For the latest version of this guide, see the Download Center on our web site at:www.contrastech.com.

Technical Support
For technical support, e-mail: support@contrastech.com. 

Do not remove the camera’s serial number label
If the label is removed and the serial number can’t be read from the camera’s registers, the warranty is void.

Do not open the camera housing
Do not open the housing. Touching internal components may damage them.

Prevent ingress or insertion of foreign substances into the camera housing
Prevent liquid, flammable, or metallic substances from entering the camera housing. If operated with any foreign substances inside, 
the camera may fail or cause a fire.

Avoid electromagnetic fields
Do not operate the camera in the vicinity of strong electromagnetic fields. Avoid electrostatic charging.

Clean with care
Avoid cleaning the sensor if possible. 

Handle this camera with care.
Do not abuse the camera. Avoid striking, shaking, etc. The camera could be damaged by improper handling.

Read the manual
Read the manual carefully before using the camera.

Perfect

Perfect

Purpose of This Guide

This guide describes the function of the iDatum and how to use it and gives a detailed description of each tools. 
The information contained in the Manual is subject to change, without notice, due to firmware updates or other 
reasons. Please find the latest version of this Manual at the Contrastech website.Please read this guide before use.

http://www.contrastech.com/en/index.html
mailto:support%40contrastech.com?subject=
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Overview

Introduction

The iDatum is designed by Contrastech for controlling and managing the machine vision cameras (including GigE Vision cameras, USB3 
Vision cameras, Camera Link cameras,10GigE cameras, and CoaXPress cameras) in your Vision system.The Software allows you to batch 
export and import features of different cameras via multiple methods, providing great convenience for camera feature configuration 
in different usage scenarios. Not just a controller, it also receives image data and allows you to view the live videos streamed from 
cameras. While viewing the live videos, you can adjust the image quality, save captured pictures and recorded videos, and adjust 
camera parameters.

With the Software, you can determine the optimal settings for your Vision system.

System Requirements

The iDatum requires that one of the following operating systems is installed on your computer:

■    Windows XP (32 bit)

■    Windows 7 (32 bit or 64 bit)

■    Windows 10 (32 bit or 64 bit) 

■    Linux 32/64-bit: Ubuntu 14.04(32/64)、Ubuntu 16.04(32/64)、 x86 platform (32/64)、

■    ARM: NVIDIA TX2 (Ubuntu16.04)、RaspberryPiB3.0+ (NOOBS_2.8.2)、ODROID-XU4 (Ubuntu16.04/Ubuntu18.04).

Computer  Requirements

Make sure the computer on which you install the client software at least meets the minimum requirements.

Recommended

● Operating System: Microsoft Windows 7/10 (32/64-bit) or Microsoft Windows XP(32-bit)

● CPU: Intel Pentium IV 3.0 GHz and above

● Memory: 4GB and above

● Display Resolution: 640 × 480 or above

● Network Adapter: Intel Pro1000, I210, I350 series

● USB 3.0: Industrial personal computer or PC needs to support USB 3.0 interface

Minimum

● Operating System: Microsoft Windows 7/10 (32/64-bit) or Microsoft Windows XP(32-bit)

● CPU: Intel Pentium IV 2.0 GHz

● Memory: 1GB

● Display Resolution: 640 × 480 or above

● Network Adapter: Intel Pro1000, I210, I350 series

● USB 3.0: Industrial personal computer or PC needs to support USB 3.0 interface
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Install

Installation Steps

1. �Download the iDatum (LEO Series Industrial Cameras SDK For xxx) from the Contrastech website:   
  http://www.contrastech.com/en/service/005001.html

2. Launch the downloaded installer.

3.Follow the instructions on the screen. The installer will guide you through the installation process.

During installation, you can choose whether to install USB3 Vision Driver or GigE Vision Driver for use with GigE camera or a USB 3.0 
camera.

After the installation process completed, Users could find the SDK (C# /VB/VC... samples) in a file folder named 
iDatum under the Start Menu.i

http://www.contrastech.com/en/service/005001.html


5 Getting Start Guide with iDatum

4. �Run iDatum app.
To begin, launch the software by simply double clicking the desktop icon, or clicking the icon in the iDatum folder in the Start Menu. 
Once the software is open, it will automatically detect all the device that is connected.
As shown below. Users can aslo click refresh button to scan all the connected devices.

5. Change IP. (For camera with Gigabit Ethernet interface)
    �Right-click on the model and select the Modify IP option to change the IP address. Please make sure the camera IP address is in 

the same subnet as the network adapter.

6. Device Connection
    �Click       button to connect the device. 

Installation Steps
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1.  Menu Bar
Function modules including File, View, Settings, Tool,and Help.

2.  Control Toolbar
     Offer buttons for file control, division settings of the display window, acquisition status, etc.

3.  Device List Panel
     Display the GigE Vision cameras, USB3 Vision cameras, and Camera Link cameras and the cameras connected via GenTL.

4.  Interface and Device Information Panel
     Display the information of the network interface or USB interface and the device information.

5.  Display Window
     View the live videos of the selected camera or local images and videos.

6.  Feature Panel
    View and configure features of the selected camera,and perform other operations such as importing,exporting, and User 
Set control.

                                               1

3

4

5

Minimize, full Screen 
and close option buttons 

6

The main window of the Software is shown as follows，The following shows the description 
of each part of the main window.

Main Window

                                               2
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Environment Configuration

Configurations before Using GigE Vision Cameras

Before using GigE Vision cameras, you should make sure that the cameras and the PC are on the same subnet, and that the Jumbo 
Frame functionality has been enabled in the Windows system.

Before You Start
Make sure that the cameras are powered on and connected to network.

Steps
– Go to Start → All Programs → IDatum → Tools in the Windows system, and then click NIC_Configurator.

– Go to Applications → NIC_Configurator in the Software's installation folder, and then click NIC_Configurator. exe.

2. Select the PC's network interface card (here after simplified as NIC) from the drop-down list.

3. Set the network adapter parameters.

Jumbo Frame
Check the Enable checkbox to enable the Jumbo Frame functionality of the NIC.

Jumbo Frame functionality can reduce the CPU usage and improve the data transmission efficiency. After enabling the Jumbo 
Frame functionality, the Jumbo Frame value will be set to 9 KB or 9014 Bytes automatically.

Receive Buffers
Set the size of Receive Buffers. Increasing the Receive Buffer size improves receiving performance while costs more system 
memory.

Transmit Buffers
Set the size of Transmit Buffers. Increasing the Transmit Buffer size improves data transmission performance while costs more 
system memory.

NIC Properties
Click Open to open the properties window of the selected NIC.



Getting Start Guide with iDatum 8

Configurations before Using GigE Vision Cameras

Internal Protocol Properties
Click Open to open the Internet Protocol Properties window, and then double-click the TCP protocol and select Obtain an IP 
address automatically.

You can also select Use the following IP address and then set the IP address to the subnet on which the camera runs.

The Internet Protocol Properties window vary with different Windows systems. The picture above is only for 
reference, the actual Internet Protocol Properties window shall prevail.i

4. Click Apply to save the settings.

● You can enable the Jumbo Frame functionality for all the NICs of the PC when installing the Software.

● Some NICs may not support Jumbo Frame. In such cases, you should update the NIC driver or change the NIC.i
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Before using USB3 Vision cameras, you should make sure that the PC on which the Software runs have installed USB driver, 
otherwise the Software will fail to enumerate the camera, or the status of the enumerated camera will be Unreachable.

When you connect a USB3 Vision camera to the PC's USB interface, the camera will be automatically detected by the Windows 
system and the USB driver will be installed automatically.

When the installation completes, USB3 Vision camera will be displayed on the Device Manger of the Windows system. You can 
right-click the camera to open the USB3 Machine Vision Camera Properties window (as shown below) to view if the device works 
properly(i.e., the driver is properly installed).

Configurations before Using USB3 Vision Cameras

If the driver fails to be installed, you can use the Driver Manager to reinstall the driver.

Before using Camera Link cameras, make sure that the Camera Link frame grabber and the driver for the frame grabber are properly 
installed on the PC on which the Software runs.

Without the driver, the Software will fail to enumerate the Camera Link cameras; without the frame grabber, the live view and 
acquisition functionality will not be available for the Camera Link cameras.

If the driver is properly installed, you can use Device Manager of the PC system to view the information of the driver and related 
serial port. If installation exception occurs, it is recommended to reinstall the driver and related software, or contact the manufacturer 
of the frame grabber for support.

Configurations before Using Camera Link Cameras

For details about the Driver Manager, see Driver Manager .i
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Menu Bar

File

The File sub-menu provides functionality related to project file, functionality for opening local files, as well as the functionality for 
exiting from the Software. Project file is useful if you need to switch global camera settings in different scenarios. You can save the 
current settings of all the connected cameras as a project file (format: mcfg) to the local PC, after which you can fast restore the 
settings of the same connected cameras by opening the saved project file.

The menu bar provides functionality such as saving and opening project file, setting display mode, software settings, tools (e.g., IP 
configurator and firmware updater), language settings, as well information of the Software and the user manual.

● When you save cameras' settings as a project file, the serial No. of the cameras are saved as well.

● Network exception, GenICam error, or failure of exporting features will cause saving failure.

● Only the feature settings of the CONNECTED cameras can be saved.
i

Save Project File for the First Time
For the first time saving, you need to select a saving path as the default saving path for project file, so next time you can skip the 
step for selecting saving path and save the project file in the default path directly.

Click on the control toolbar or click File → Save to open the Save Project File window,and then select a saving path as the 

default saving path for project files, and finally click Save.

Save Project File in Custom Saving Path
After the first project file being saved in the default saving path, the function of saving in custom path will be available.

Click on the control toolbar or click File → Save as to open the Save Project File window, and then select a custom saving path, 

and finally click Save.

You can click View on the prompt popped up when saving completes to go to the saving path of the project file.i

Open Project File
You can open a project file to restore the saved feature settings to the cameras with matched serial numbers. Two scenarios are 
involved in the opening of a project file.

Scenario 1: The Software Has been Running 

When the Software has been running, you can perform one of the operations in the following list to open a project file.

● Click File → Open Recent and then select a recently saved project file to open it.

● Click on the control toolbar or click File → Open to open the Selected Project File window, and then select a project file from 

the PC, and finally click Open.

Scenario 2: The Software is Not Running

Double-click the project file, and then the Software will run and the cameras with the matched serial numbers will be connected 
automatically, and the feature settings information contained in the file will be imported to the cameras as well.

Open Local File
You can open local images and video files to view them on the display window of the Software. For details, see View Local Image 
and Video.

You can click View on the prompt popped up when saving completes to go to the saving path of the project file.i
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You can adjust the image quality of the live video by setting the display mode, filtering mode, vertical synchronization mode, and 
rendering engine.

View

Set Vertical Synchronization
By enabling vertical synchronization, screen tearing on images will be prevented.

You can click View → Vertical Synchronization to enable vertical synchronization.

The settings will be effective for all cameras on the Software.i

You should have set the rendering engine to D3D before setting vertical synchronization.i

Set Display Mode
You can click View → Display Mode and then select 30 fps or 60 fps to set the image frame rate to 30 frames per second or 60 
frames per second respectively.

Set Rendering Engine
You can click View → Rendering Engine to set the rendering engine mode to D3D or GDI.

The larger the image frame rate, the better the image quality.i

Set Filtering Mode
During live view, you can click View → Filtering Mode to select the filtering mode so as to change the image quality level.

The image quality levels of different filtering modes: Disabled < Nearest Filtering < Bilinear Filtering< Anisotropic Filtering.

● By default, the rendering engine mode is set to GDI, which is applicable to all PCs for it doesn't have 
requirements for the performance of the graphics card.

● The image quality of D3D mode is better than that of GDI mode, but D3D mode is only applicable to the PC 
which has been installed with graphics driver (and the available memory of the graphics card should be more than 
1 GB).

i

● You should have set the rendering engine to D3D before setting filtering mode.

● The better the image quality, the more system resources will be occupied.

● For details about live view, see Acquisition and Live View.
i
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You can configure settings for the Software, including general parameters, recording and capture parameters, buffer size, and 
packet resending parameters via the Settings sub-menu.

Settings

General Settings
You can set the general parameters, including user level, auto-refresh settings of the device list, character encoding type, and cti 
default path.

Go to Settings → General to configure the following parameters.

User Level
You can select Beginner, Expert, or Guru as the user level, which determines the visibility of features for users of different 
professional knowledge levels. The higher the user level, the more camera features will be displayed on the feature panel.

Application Options
You can turn on Camera List Auto-Refresh to refresh the camera list (device list) automatically.

Camera Link camera doesn't support device list auto-refreshing.i
ACK mode of devices Discovery
The communication mode between the Software and the detected IP addresses in the same network segment with the PC 
where the Software runs. By default, the ACK mode is Broadcast. If the Software fails to enumerate a camera, you can switch it to 
Unicast and try again.

Character Encoding Type
The encoding type of characters displayed on the Software interface. If you find a character on the interface unreadable, change 
the character encoding type and try again.

Local encoding type refers to the encoding type of the current PC where the Software runs. UTF-8 is a method for encoding 
Unicode characters using 8-bit sequences.

Bayer Interpolation
The interpolating modes for transferring an image of bayer format to RGB format.

cti Default Path
cti file is used for GenTL management. You can set a default path for cti file. If you have configured and enabled the default path 
of cti file, the Software will load it automatically once you start the Software. See GenTL Management for details about GenTL

management.

Temperature Screening Settings
Normal Region Color
The color or regions with normal temperature.

Alarm Region Color 1/2
The two colors of regions with an alarm triggered by abnormal temperatures.

● If the alarm of screening region is not acknowledged after 200 seconds, the two colors will flash by turns.

● To display the colors of screening regions, you need to finish the following operations beforehand.

○ Draw a temperature screening region. See Temperature Screening Configuration.

○ Set alarm rules of temperature screening regions. See Configure Temperature Screening Parameters.

○ Select Region Information Overlap as Client.

i

Output Logs
Logs about temperature screening can be output if you enable this.
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Settings

Capture and Recording Settings
You can set the recording parameters and capture parameters as required.

For details about capture and recording, see Capture and Recording.i

The maximum pictures that can be auto saved depends on the storage space of thesaving path you set.i

Go to Settings → Recording/Capture to configure the following parameters.

Select Directory
Select Directory for the captured pictures and recorded videos.

Saving Path
Set a saving path for the recorded video files or captured pictures during live view.

Auto Save
When enabled, the recorded video files or the captured pictures during live view will be automatically saved to the saving 
path you set.

Recording
Set parameters related to recording.

Video Format
Set format (AVI or RAW) for the recorded video files.

Video Quality
If you set AVI as the video format, you can select Normal, Better, or Best from the drop-down list as the video quality, or 
drag the slider to adjust the compression ratio so as to set video quality.

The compression ratio for Normal is from 0 to 40, for Better from 41 to 70, for Best from 71 to 100.

The higher the compression ratio is, the better the video quality. The better the video quality, the more image 
details can be displayed.i

Playback Speed
If you set AVI as the video format, you can set the playback speed for the recorded video files.

Original Frame Rate
Set the original frame rate of the recorded video file as the playback speed.

Custom
Enter a frame rate as the playback speed. 

Video Naming Rule
Customize a prefix and select Date and Time or Increasing No. as the naming rule.

Date and Time
The video name will be a number which represents the data and time when the video file is saved. For example, if you set 
Video as the prefix of the name, the full name would be Video_20190424051532390.

Increasing No.
The video names will be increasing No. For example, if a video file is the second one you saved and you set Video as the 
prefix, the full name of the video would be Video_02.

Capturing
Set parameters related to the capturing of pictures.

Picture Format
Set format (BMP, RAW, JPG, PNG, TIFF) for the captured pictures during live view.

Picture Quality
If you set JPG or PNG as the picture format, you can select Normal, Better, or Best from the drop-down list as the picture 
quality, or drag the slider to adjust the compression ratio so as to set picture quality.

The compression ratio for Normal is from 0 to 40, for Better from 41 to 70, for Best from 71 to 100.

The higher the compression ratio is, the better the picture quality.i
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Settings

File Naming Rule
Customize a prefix and select Date and Time, Frame No., or Time Stamp as the naming rule for the captured pictures.

Date and Time
The picture name will be a number which represents the data and time when the video file is saved. For example, if 
you set Image as the prefix of the name, the full name would be Image_20190424051532390.

Frame No.
The picture names will be frame No. For example, if a picture file is the second one you saved and you set Image as 
the prefix, the full name of the video would be Image_02.

Time Stamp
The picture name will be a serial number which represents the timestamp. For example, Image_00000001576677065.

Continuous Capture
Set the capture mode.

Capture by Frame
The pictures will be captured by frame(s) and the capture will be stopped after the set number of frames . For 
example, if you set "Capture Every 3 Frame(s)" and "Stop Capturing after 1000 Frame(s)" as the capture mode, a 
picture will be captured for each 3 frames, and the capture actions end after 1000 frames being acquired.

Capture by Time
The pictures will be captured by time and the capture will be stopped after the time period you set. For example, if 
you set "Capture Every 2 Second(s)" and "Stop Capturing after 5 Minute(s)" as the capture mode, one picture will be 
captured each two seconds, and the capture actions will last 5 minutes.

Network Settings
You can configure the network settings, including automatic network detection, adaptive dropping frame, and packet loss prompt.

You can enable or disable Automatic Network Detection and (or) Adaptive Drop Frame to ensure the fluency of the image data 
acquisition according to the actual network environment.

You can also enable Packet Loss Prompt to allow the Software to pop up a prompt if the packet loss occurs.

Buffer Settings
Buffer settings allow you to balance image quality against image fluency.

You can adjust the values of Buffers for Getting Stream and (or) Buffers for Capture and Recording according to the memory 
conditions.

Buffers for Getting Stream
The maximum value is 30.

Buffers for Capture and Recording
The maximum value is 10000.

Resend Packet
Packet resending is a mechanism to ensure image quality by resending the lost or damaged packets during image data acquisition. 
You can set the packet-resending for the Software, including maximum packet resending percent and the timeout period for packet

resending.

You can set the Resend Packet switch to on to enable the Software to resending packets, and then configure the following 
parameters.

Max. Packet Resending Percent (%)
The maximum percent of packets resent within one frame (default value: 10%). With larger packet resending percent, you can get 
more complete image data. Conversely,you can get more real-time image data.

Timeout Period(ms)
The maximum time period (default value: 50 ms) that the Software can wait between two packets that need to be resent (either 
for the packet is lost or damaged). If the waiting time exceeds the time you set, the Software will not wait for or resend any

packet.

● You can set a relatively long timeout period if there are excessive packet losses.

● You can set the value of Timeout Period from 0 ms to 1000 ms.
i
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Settings

Shortcut
The Software provides default keyboard shortcuts for some frequently-used functions such as connecting/disconnecting camera 
and starting and stopping acquisition. You can customize the shortcuts according to your actual needs.

The Delete key cannot be used as a keyboard shortcut.i
Click Settings → Shortcut to enter the Shortcut page.

You can do the following operations.

● Customize a Shortcut: Select the text field of a function (such as Start/Stop Live View), and then press one or more keys at the 
same time to set a shortcut for the function.

● Delete a Shortcut: Select the text field of a function, and then press the Delete key to delete the shortcut.

● Enable Respond in Priority: When you turn on Respond in Priority, the shortcut of the Software will still be executed even if the 
Software is minimized or not on the top layer of the PC desktop.Restore Defaults: Click Restore Defaults to restore the shortcuts for

all the listed functions to the default settings.
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The Software provides multiple tools for camera configuration and management.

The following table shows the brief description of each tool.

Tool

IP Configurator
Configure the IP address of the GigE Vision cameras. See IP Configurator for details. 

Firmware Updater
Update the firmware of GigE Vision cameras and USB3 Vision cameras. See Firmware Updater .

Import/Export Features 
Export the selected cameras' feature configuration information as a MFS file to the local PC, or import the MFS file containing

camera feature information from the local PC to the selected cameras. See Import/Export Features of Multiple Devices for details.

Log Viewer 
View SDK logs. See Log Viewer Tool for details.

Virtual Camera
Virtual Camera is a tool designed for scenarios where constructing a real setup of camera environment is not feasible. It can simulate 
cameras and help to simplify tests during development stage.

Bandwidth Manager
Adjust the bandwidth of the connected cameras to avoid excessive packet losses. See Bandwidth Manager for details.

GigE Vision Action Command
Trigger actions in multiple cameras at the same time. See GigE Vision Action Command for details.

Export All Devices Information
Export information of all cameras enumerated on the Software and the information of the current PC in a folder. The information 
includes device logs, NIC information of the current PC, computer and system information, driver status of the current PC, and 
camera parameters. The information will be saved as TXT documents.

The Help sub-menu offers access to the language switching functionality, user manual,SDK documents, and the Software information.

Click Help → Development to view the SDK documents. 

Help

Folder Name Description

Bin The executable programs compiled using demo.

Documentations SDK documents including SDK Development Guide and Demo User Manual .

DotNet DLL(s) developed via C#.

Includes Header files.

Libraries Static libraries.

Samples

Sample codes of various programming languages.

ThirdPartyPlatformAdapter Third-party plug-ins.

You can also click Start → iDatum → Samples in the Windows system to access the 
Samples folder.i
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Device Management

GigE Vision Camera Management

GigE Vision camera is the camera using GigE Vision interface standard for data transmission. After connecting GigE Vision cameras 
to the Software, you can perform operations such as Multicast settings, saving GenICam XML, and editing device user ID.

On the device list, the devices are classified into four types, namely, GigE, USB, Camera Link, and GenTL, according to the camera 
interface. After connecting cameras to the Software, you can perform operations such as saving GemICam XML, and using Event

Monitor to determine issues that may occur on your cameras.

For details about status of the GigE Vision cameras, see Status of GigE Vision Camera.i

Connect GigE Vision Camera
You can connect GigE Vision cameras to the Software in three ways, i.e., letting the Client automatically enumerating local cameras, 
connecting camera by command, or adding remote camera.

Automatically Enumerate Local Cameras
All the GigE Vision cameras in the same local subnet with the Software will be automatically enumerated in the device list.

You can hover the cursor over the camera interface and then click to refresh the enumerated cameras on the same local 
subnet with the PC on which the Software runs.

Or you can enable the Software to automatically refresh the device list. See Settings for details.

When the cameras are enumerated, if the camera status is available, you can double-click the camera or click to connect it to 
the Software.

GigE Vision is an interface standard for machine vision cameras. It provides a framework for transmitting high-
speed video and related control data over Ethernet networks.i

Connect Camera by Command
You can use CMD commands to run the Software and connect cameras to it.

Steps
1. Go to Start → CMD.

2. Enter "cd" and "the directory of iDatum.exe".

Example
If the directory of iDatum.exe is "C:\Program Files (x86)\iDatum\Applications\Win64", you should enter "cd /d C:\Program 
Files (x86)\iDatum\Applications\Win64".

3. Press the Enter key.

4. Connect the camera to the client software in the following four ways:

– Connect by Camera IP Address: Enter "iDatum.exe/IP xx.xx.xx.xx".

Connection by IP address is not supported by USB3 Vision camera, Camera Link camera, and CoaXPress camera.i
– Connect by Camera Serial Number: Enter "iDatum.exe/SN xxxxxxxx".

xxxxxxxx here refers to the camera serial number.i
– Connect by Camera Mac Address: Enter "iDatum.exe/Mac xx.xx.xx.xx.xx.xx".

● Connection by Mac address is not supported by USB3 Vision camera and Camera Link camera.

● xx.xx.xx.xx.xx.xx here refers to the camera Mac address.
i
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GigE Vision Camera Management

Example
If the directory of the mcfg is "C:\Users\VB2100\Desktop\CDE" and the name of the mcfg file is "CDE", you should enter 
"iDatum.exe/mcfg C:\Users\VB2100\Desktop\CDE\CDE.mcfg".

5. Press the Enter key.

Result
The Software will start running and parsing the entered parameters such as camera IP address, and then the camera will be 
connected automatically.

Add Remote Camera
You can add GigE Vision camera NOT in the same local subnet with the client software to the device list.

Steps
1. Right-click the network interface card (for example, Local Area Connection in the following picture) to open the right-click 
menu.

– Connect by Opening Project File: Enter "iDatum.exe/mcfg" +"the directory of the mcfg file"+"mcfg file name.mcfg".

You should have saved camera features as project file. For details about how to save camera features as project 
file, see File.i

2. Click Add Remote Camera to open the Add Remote Camera window.

3. Enter the camera IP address and then click OK to add the camera.



19 Getting Start Guide with iDatum

Status of GigE Vision Camera 
The Software provides multiple icons to represent different status of GigE Vision cameras.

The following table shows the descriptions of the status of the GigE Vision camera on the device list.

GigE Vision Camera Management

Icon Description

Available and disconnected.
You can double-click the camera or select it and click on the control toolbar to connect it to the Software. Once 

connected, changes to .

Connected.

The camera is acquiring streams.
See Acquisition and Live View for details about how to start acquisition.

Not available. Another Software or process is accessing the camera.

The camera is on the same subnet with the PC on which the Software runs, but NOT in the same network segment.
You should configure its IP address to the same network segment before you can connect and use the camera.You can 
double-click the camera or click Tool → IP Configurator to configure the camera's IP address. See IP Configurator for 
details about how to configure camera IP address.
Multicast of the camera is enabled on another Software. And the camera is not connected to the current Software.
See Multicast Settings for details about how to enable Multicast.
Multicast of the camera is enabled on another Software. And the camera is connected to the current Software.
See Multicast Settings for details about how to enable Multicast.

Edit Camera IP Address 
If the camera is displayed as  (not reachable for the camera is on the same subnet with the PC on which the Software runs, but 
not in the same network segment), you can edit the camera's IP address to make it reachable.

Steps   

● Right-click the camera displayed as  to open the right-click menu.

● Click Modify IP on the right-click menu to edit IP address of the camera.
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Multicast Settings 
By enabling Multicast, a GigE Vision camera can be accessed through multiple Softwares.

This is especially useful when a camera needs to be accessed by different end users.

Before that, you need to configure roles for the Softwares to specify different permission for them to access different cameras.

GigE Vision Camera Management

● Enable Multicast When Camera is Available but Disconnected
If the camera status is available and disconnected, you can set "Controller" or "Controller and Receiver" as the Software's role. 

Steps   
1. Right-click a camera (available and disconnected) on the device list to open the right-click menu.

2. Click Multicast Setting to open the Multicast Setting window.

3. Select Controller from the Role drop-down list.

4. Click OK to save the role settings.

The camera will be connected and Multicast will be enabled automatically.

5. Optional: Edit the IP address and port.

IP Address
The IP address of the selected camera.

Port
The port No. of the selected camera.

6. Click OK to save the settings.

After enabling Multicast mode of a camera on Software A, if the camera is remotely added to Software B, or the camera is on the 
same local subnet of the PC on which the Software C runs, the camera will be displayed as (when disconnected) or (when

connected) on Software B or Software C. And the role of Software B and Software C (relative to the camera) will be "Data Receiver".

● Multicast configuration is only available for GigE Vision cameras.

● Multicast configuration should be supported by the GigE Vision camera.i
For different cameras, a Software can be configured with different roles to access them. In other words, the end user of a Software 
can have different permissions to access different cameras. The following roles are available:

Role Description

Controller and Data
Receiver

The camera's features are editable, and the Software can receive camera data to display live image.

Controller The camera's features are editable, but the Software cannot  receive camera data to display live images.

Data Receiver
The camera's features are NOT editable, but the Software can receive camera data to display live images.
● You cannot set the role of a Software as Data Receiver manually.
● Multiple Softwares can be Data Receiver of the same camera.

● For one camera, only one Software can be the role of "Controller and Data Receiver" or "Controller".

● You can configure Multicast for a camera only when the role is set to "Controller and Data Receiver" or "Controller".

● For the Softwares running on the same PC, one of them can only be configured as "Controller" and the others as 
"Data Receiver".

i
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GigE Vision Camera Management

● Enable Multicast When Camera is Connected
For a connected camera, you can only set the Software's role to "Controller and Receiver".

Steps   
1. Right-click the camera and then click Multicast Setting to open the Multicast Setting window.

The role for the current Software is set to "Controller and Data Receiver" by default and cannot be edited.

2. Turn on the Enable switch to enable Multicast.

The IP Address field and Port field appear.

3.Optional: Edit the IP address and port.

IP Address
The IP address of the selected camera.

Port
The port No. of the selected camera.

6. Click OK to save the settings.

After enabling Multicast mode of a camera on Software A, if the camera is remotely added to Software B, or the camera is in the 
same local subnet of the PC on which the Software C runs, the camera will be displayed as  (when disconnected) or  (when

connected) on Software B or Software C. And the role of Software B and Software C (relative to the camera) will be Data Receiver. In 
this scenario, the user has the permission to modify the camera's features, as well as view the live video of the camera on Software 
A; While on Software B and Software C, the user has no permission to modify the camera feature, but can view the live video and 
features of the camera.
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Other Features 
Other features are provided for the GigE Vision cameras on the device list, including GVCP Settings, GVSP Settings, GenICam XML 
settings, device user ID settings, etc. 

GigE Vision Camera Management

● GVCP Settings 
GVCP is short for GigE Vision Control Protocol, which is a communication protocol for the communication between the Software 
and a GigE Vision camera. GVCP allows the Software to configure and control a GigE Vision camera. The Software sends a command 
and waits for an acknowledgment (ACK) from the camera before sending its next command, hence data integrity is ensured. In this 
ACK scheme, the Software can get and set various features of the camera.

When the network condition is not good, data losses may occur in this ACK scheme. In this case, you can configure the GVCP 
settings to allow the Software to resend the command for multiple times within a certain time period, hence data losses can be 
alleviated.

Resending Times
Specify the times for resending the command.

The default value is 3, and the value range is from 0 to 100.

Timeout
Specify the time period (ms) for resending the command. In other words, if the time for resending the command reaches the 
specified time period, command resending will end.

The default value is 500, and the value range is from 0 to 10,000.

○ GVCP settings is only available when the camera is connected or in acquisition.

○ Cameras connected via frame grabbers does not support this function.i
Right-click a GigE Vision camera and then click GVCP Settings to open the GVCP Setting window and then configure the two 
parameters below.

Saving GemICame XML is only available when the camera is connected or in acquisition.i

● GVSP Settings
GVSP is short for GigE Vision Streaming Protocol, which provides a protocol for getting non-compressed and compressed data 
streams. For transmission an image is split into several packages and the packages are recompiled when received. When you set the

Timeout, you set the waiting duration between each package of an image. If the next package is not received when the waiting 
duration is longer than the Timeout value, the Software will stop receiving the following packages of image and recompile packages

received before. When the network condition is not good, setting a short Timeout may cause a low resolution of the image; while 
setting a long Timeout may lower the continuity of image acquisition.

○ GVSP settings is only available when the camera is connected.

○ By default, the Timeout is 300.

○ Cameras connected via frame grabbers does not support this function.
i

Right-click a GigE Vision camera and then click GVSP Settings to open the GVSP Setting window and then configure Timeout.

Save GemICam XML
Right-click a GigE Vision camera, and then click Save GemICam XML to save the camera information as XML file for purposes 
such as secondary development of the Software.

Renaming user ID is only available when the camera is connected or in acquisition.i

Rename User ID
Right-click a GigE Vision camera, and then click Rename User ID to edit user ID of the camera.

Configure NIC
Right-click a GigE Vision interface and then click NIC Settings to set NIC parameters. For details, see Configurations before Using 
GigE Vision Cameras.

Stick Camera to Top
Right-click a GigE Vision camera and then click Stick to Top to stick the camera to the top of the GigE Vision camera list.

If you want to cancel sticking the camera to the top, right-click the camera and then click Cancel Sticking to Top.
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USB3 Vision Camera Management

Add USB3 Vision Camera 
You can add USB3 Vision camera to the Software in two ways, i.e., by automatically enumerating camera, or by command.

● After you connecting a USB3 Vision camera to the PC on which the Software runs, the camera will be automatically enumerated if 
the USB driver is properly installed. For details about automatically enumerating camera, see Automatically Enumerate Local Cameras.

● You can also connect a USB3 Vision camera to the Software by command. For details, see Connect Camera by Command.

Status of USB3 Vision Camera 
The Software provides multiple icons to indicate the status of the USB3 Vision camera.

You can do further management according to the status of the cameras.

The following table shows the descriptions of different status. 

Icon Description

Available and disconnected.
You can double-click the camera or select it and click on the control toolbar to connect it to the Software. 
Once connected, the status changes to .

Connected.

The camera is acquiring image data.

Not available. Another software or process on the same PC is accessing the camera.

USB driver exception. You should reinstall the USB driver.

Available and disconnected (the USB interface of the PC is USB2.0 interface).

Connected (the USB interface of the PC is USB 2.0 interface).

The camera is acquiring image data (the USB interface of the PC is USB2.0 interface).

Not available (the USB interface of the PC is USB 2.0 interface).
Another software or process on the same PC is accessing the camera.
USB driver exception (the USB interface of the PC is USB 2.0 interface).
You should reinstall the USB driver.

USB3 Vision camera is the camera using USB3 Vision interface standard for data transmission. You can connect USB3 Vision to the 
Software for further management such as image data acquisition.

Other Features
Other features are provided for the USB3 Vision cameras on the device list, including U3V Transfer settings, device user ID settings, 
GenICam XML settings, etc.

● U3V Transfer Settings 
You can edit the packet size and streaming channels for a USB3 Vision camera.

Right-click a USB3 Vision camera and then click U3V Transfer Setting to open the U3V Transfer setting window, and then configure 
Packet Size (value range: 64 to 20,480 KB,default value: 1024 KB) and Streaming Channel(s) (value range: 1 to 10, default value: 8)

according to the performance of the USB frame grabber. The lower the performance of the USB frame grabber, the smaller the 
Packet Size and the more Streaming Channel(s) you should set so as to alleviate data transmission between and camera and the 
Software.

U3V transfer settings is only available when the camera is connected or in acquisition.i
● Save GemICam XML
Right-click a USB3 Vision camera, and then click Save GemICam XML to save the camera information as XML file for secondary 
development of the Software.

Saving GemICame XML is only available when the camera is connected or in acquisition.i
● Rename User ID
Right-click a USB3 Vision camera, and then click Rename User ID to edit user ID of the camera.

Renaming user ID is only available when the camera is connected or in acquisition.i
● Stick Camera to Top
Right-click a USB3 Vision camera and then click Stick to Top to stick the camera to the top of the USB3 Vision camera list.

If you want to cancel sticking the camera to the top, right-click the camera and then click Cancel Sticking to Top.
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Camera Link Camera Management

Camera Link camera is the camera using Camera Link standard for data transmission.

After adding Camera Link cameras to the Software, you can do further operations such as camera parameter configuration.

Status of Camera Link Camera
The Software provides two icons to indicate the status of the Camera Link camera. You can do further management according to 
the status of the cameras.

The following table shows the descriptions of different status.

Icon Description

Available and disconnected.
You can double-click the camera, or select the camera and then click on the control toolbar to connect it to the 

Software. Once connected, the status icon changes to .

Connected.

2. Connect the camera to the Software.

3. Optional: Right-click the camera, and then click Connection Parameter Settings to set the baud rate of the camera.

Camera Link is a serial communication protocol standard designed for camera interface applications based on the 
National Semiconductor interface Channel-link.i

● The Software doesn't support acquisition and live view for the Camera Link cameras.

You can only manage features of Camera Link cameras after connecting them to the Software if no third-party 
frame grabber is installed on the PC.

● To acquire streams and view live view of Camera Link cameras, you should have installed third-party frame 
grabber on the PC.

● Camera Link camera doesn't support Bayer settings and ROI/AOI settings.

i

● The time for refreshing Camera Link camera is longer than that of other types of camera. Please wait patiently.

● The Camera Link camera may be enumerated for two times via serial port and frame grabber respectively.i

Add Camera Link Camera
The Software supports Camera Link camera. You can connect Camera Link cameras to the Software to perform further operations 
such as camera feature configuration.

Before You Start   
You should have properly connected Camera Link camera to the PC on which the Software runs. 

Steps   

1. Move the cursor to Camera Link, and then click to refresh the Camera Link Camera list.

The camera will be displayed under the Camera Link interface of the device list.

The higher the baud rate, the faster the signals can be transmitted.i
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GenTL Management

The GenTL (short for Generic Transport Layer) standard provides a generic way to allow the Software to enumerate cameras, 
communicate with cameras, and if possible, stream data from cameras independent from the underlying transport technology, and 
configuring features of connected frame grabbers. This allows the Software to control cameras (including third-party cameras) and 
to acquire data in a transport layer agnostic way.

Steps
1. Right-click GenTL on the device list and then click Select cti File.

2. Select a cti file from the local PC and load it.

Icon Status Description

Available The frame grabber can be connected and operated.

Connected The Software has been connected to the frame grabber. You can configure parameters of the
frame grabber and enumerate cameras connected to the frame grabber.

● The cti files of GigE interface and USB3 Vision interface are provided by the Software (directory: C:\Program Files 
(x86)\Common Files\iDatum\Runtime\Win32_i86 or C:\Program Files (x86)\Common Files\iDatum\Runtime\Win64_
x64). 
● The Software supports loading the cti files of GigE, CameraLink, CoaXPress frame grabber. The saving path of the 
file is C:\Program Files (x86)\Common Files\iDatum\Runtime\Win32_i86 or C:\Program Files (x86)\Common Files\
iDatum\Runtime\Win64_x64.

File Name Device Type

MvFGProducerCML.cti Camera Link frame grabber.

MvFGProducerCXP.cti CoaXPress frame grabber.

MvFGProducerGEV.cti GigE frame grabber.

MvProducerGEV.cti Camera with GEV interface.

MvProducerU3V.cti Camera with USB interface.

MvProducerVIR.cti Virtual camera.

● The Software also supports third-party cti files which conform to the GenTL standard.

● For third-party cti files, you need to get them by yourself. You can contact the corresponding manufacturer for 
support.

● If you have configured the default path of cti file, the Software will load it automatically once you start the Software. 
See General Settings for details about how to set the default path of cti file.

i

Reboot the PC after upgrade, or the upgrade will not take effect.i
Clear the currently loaded cti file: Disconnect all cameras under GenTL. Right-click GenTL, and then click Clear cti File.

The device list will enumerate the cameras that can be discovered by the cti file.

CoaXPress cameras can only be connected by GenTL. If connected, you can control the camera and acquire image 
data.i

3. Optional: Connect the frame grabber, and then click to refresh cameras after loading the cti file.

Different icons indicate different status of a frame grabber.

The cameras connected to the enumerated frame grabber will be displayed. You can double-click a camera to connect to it.

4. Optional: Perform the following operations.

● For CameraLink frame grabbers which cannot enumerate real cameras, right-click a frame grabber and select Open as a Virtual 
Camera to connect and operate the cameras of the frame grabber as virtual cameras.

● After connecting to the frame grabber, the feature tree of the frame grabber will be displayed on the right. Configure the features 
if necessary.

● After connecting to the frame grabber, right-click it and then select Save GenlCam XML to save the frame grabber's GenlCam file 
to the PC in XML format.

● After disconnecting to the frame grabber, you can right-click the frame grabber and select Upgrade Firmware to upgrade its 
firmware.

● Upgrade firmware of a single camera connected to frame grabber: Click to connect to a frame grabber and enumerate 
cameras connected to it. Right-click a camera and select Upgrade Firmware. Click to select an upgrade package (a dav file), and 
then click Upgrade.
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Event Monitor

The Event Monitor is a tool to determine causes of issues that may occur when using the device. When enabled, you can view all the 
time-stamped GigE Vision or USB3 Vision events. 

Steps   

8. Optional: Click Clear Log at the upper-right side of the window to clear all the events displayed before.

1. Connect the camera with the software by one of the following operations.
– Select a camera from the device list and click on the control toolbar to connect it with the software.
– Double-click the camera on the device list to connect it with the software.

2. Select Advanced Features tab on the Feature List Panel on the right of the main page.
3. In Event Control Information, check the event(s) that you want to view.
4. Right-click the camera on the device list and select Event Monitor to open the Event Monitor window.
5. Check Messaging Channel Event.
6. Optional: Click to select a saving path, and then check Auto Save to automatically save the generated events to the PC.
7. Start acquisition, and then a large number of events will appear on the Event Monitor window.

– Click on the display window to start acquisition.
– Right-click the camera on the device list and click Start Acquisition.

The Event Control feature should be supported by your device, or the Event Monitor functionality will be unavailable.i

● Up to 10000 events can be displayed on the Event Monitor window.

● Events will keep being obtained even if you close the Event Monitor window.i
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Add a Virtual Camera

Virtual Camera is a tool designed for scenarios where constructing a real setup of camera environment is not feasible. It can simulate 
cameras and help to simplify tests during development stage.

Steps   
1. Click Tool → Virtual Camera to open the Virtual Camera window.

2. On the Virtual Camera window, select and add the camera models you want to simulate.

The added virtual cameras will be displayed on the Device List.

The supported virtual camera models are subject to the displayed options.i

If there is no virtual camera displayed, click to refresh.i
3. Optional: You can also add virtual cameras via GenTL. Right-click GenTL and click Select cti File. Select and open MvProducerVIR.
cti file to display virtual cameras.

4. Double-click a virtual camera to show the feature tree of the camera.

5. Select a pixel format at the Image Format Control part.

6. Go to C:\Windows\Temp\VirtualCamera\Cameras, and find the file folder named by the virtual camera No.

7. Open the file folder, and then put images in the file folder named Mono8 or RGB24.

Make sure the resolution of the images is the same with the resolution of the camera.i
8. Optional: Perform further operations as needed on the Virtual Camera window.

● Change Online Mode: Right-click the virtual camera and click Change Online Mode to switch its mode between online and offline.

● Delete a Virtual Camera: Right-click the virtual camera you want to delete, and click Delete to delete it.

● Reset All Virtual Cameras: Click Reset All Virtual Cameras to reset all added virtual cameras to their default settings.

What to do next   
Start acquisition of the camera to play the imported images.

Dead Pixel Correction

You can conduct dead pixel correction on a camera to fix dead pixel.

Before You Start   
Make sure that the camera has been connected to the Client.

Steps  
1. Select a camera on the device list.

2. Right-click the camera name and select Dead Pixel Correction.

3. Optional: Export the dead pixel file and edit the dead pixel information.

4. Select a dead pixel file (MFA format) and click Import.

A progress bar will be displayed when importing, and a message box noting "Imported" will pop up when the import is finished.
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Camera Feature Configuration

Feature Tree

Features are capabilities of the cameras and camera modules that can be controlled by setting firmware parameters. The feature 
tree displays all available features of a connected camera and you can edit the parameters under each feature.

The Software provides multiple methods to configure the camera features, including configuring manually, configuring via User Set, 
configuring via project file, configuring via File Access, and batch exporting and importing features.

The available features of the camera vary with different camera models.i
Generic Operation Description

Show or Hide Features Click to show or hide the camera features under all feature categories.

Switch User Level
Switch user level (Beginner, Expert, or Guru) at the bottom of the Feature Tree tab.
The higher the user level, the more camera features will be displayed. Guru Level provides the 
most comprehensive camera features for professional use.

Add Feature/Parameter
to Favorites

Right-click a frequently-used feature category or a specific feature/parameter, and then click Add 
to Favorites to add it to the Favorites.
By default, the features/parameters added to Favorites are ranked by time. You can drag the 
added feature/parameter to adjust its rank.

View Description of
Feature/Parameter Click the name of a feature or parameter to view its description at the bottom of the tab page.

Switch Language Click to switch the language of this pane to Chinese.
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The following table briefly introduces the description of each feature category.

Feature Tree

Feature Category Description

Device Control 

Contains the features related to the control and information of the camera.
You can do the followings:
● View the camera details including device type, version, manufacturer details, device ID, device 
temperature, etc.
● Modify the alias and reset the camera.

Image Format 
Control 

Contains the features related to the format of the transmitted image.
You can do the followings:
● View the live view image width and height, pixel size, etc.
● Set ROI, modify pixel format, set image reverse, test pattern,and set the embedded information, etc.

Acquisition Control Contains the features related to image acquisition, including trigger and exposure control.
You can set the trigger mode, trigger source, acquisition mode,etc.

Analog Control Contains the features related to the video signal conditioning in the analog domain.
You can adjust the analog signal including analog gain, black level, brightness, gamma, sharpness, AOI, etc.

LUT Control Contains the features related to the look-up table (LUT) control.
You can view the user look-up table and set the LUT index and value.

Digital IO Control Contains the features related to the control of the input and output pins of the camera.
You can manage the digital input and output.

Action Control Contains the features related to the control of action command.
You can use the features to define the mechanism of the action command.

Counter And Timer 
Control 

Contains the features related to the usage of programmable counters and timers.
You can set the counter and timer, which count the triggering signal and control the exposure according to 
your needs.

File Access Control Contains the features related to accessing files in the camera.
You can use File Access to export and import camera settings.

Event Control 
Contains the features related to the generation of event notifications by the camera.
You can use Event Monitor to view the messaging channel events to determine causes of issues that may 
occur during the use of your camera.

Chunk Data Control 
Contains the features related to the generation of supplementary image data (i.e., Chunk data) and the
appending of that data to every image that you acquire.
You can enable chunk data, and set the content of the chunk data.

Transport Layer 
Control 

Contains the features related to the control of transport layer.
You can set the parameters of transport layer of the camera.

User Set Control 

Contains the features related to the global control of camera settings.
User Set Current
The currently loaded user set.
● "0" represents Default, i.e., the factory settings.
● "1" represents UserSet1.
● "2" represents UserSet2.
● "3" represents UserSet3.
User Set Selector
Select User Set.
The number of User Sets vary with different camera models.

Default
The read-only factory settings. In other words, the default startup settings on the camera.
User Set1, User Set2, User Set3
The user sets that can be used to load and save your own camera settings.
Initially, these user sets contain the same parameter values as the Default user set. You can save one of 
them to overwrite those values with your own settings to create a user set that is customized for your 
usage scenario. See the description of User Set Save below for details about saving User Set.

User Set Load
Load the User Set specified by User Set Selector to the camera and make the it active. When a user set is 
loaded, it overwrites the current camera settings.
● Loading a user set is only possible when the camera is idle, i.e., not acquiring images.
● Except for the Default user set, you should have saved a User Set before you can load it. See the 
description of User Set Save below for details about saving User Set.
User Set Save
Save your own camera settings as the User Set specified by User Set Selector.
● Only the UserSet1, UserSet2, and UserSet3 can be saved.
The other user sets are read-only.
● Saving a user set is only possible when the camera is idle,i.e., not acquiring images.
User Set Default
Select User Set to automatically load and make it active by default when the camera is reset to its power up 
state.
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Common Features

On the Common Features tab, you can configure the features which are frequently used in camera configuration, including basic 
features (Acquisition Frame Rate Control Enable,Exposure Auto, Gain Auto, etc.), ISP, and transport layer control.

Basic Features
The Basic Features allow you to set features like Acquisition Frame Rate, Exposure Time, Gain, etc.

Acquisition Frame Rate Control Enable
Controls if the Acquisition Frame Rate feature is adjustable and used to control the acquisition rate. Otherwise, the acquisition 
rate is implicitly controlled by the combination of other features like Exposure Time, etc.

Acquisition Frame Rate(Fps)
Set an upper limit for the frame rate (fps) at which frames are captured.

This is useful if you want to operate the camera at a constant frame rate in continuous image data acquisition.

Resulting Frame Rate(Fps)
Displays the value of the maximum allowed frame rate (fps) in image data acquisition.

In continuous acquisition, the Resulting Frame Rate parameter is useful for optimizing the frame rate for your imaging application. 
You can adjust Acquisition Frame Rate until the Resulting Frame Rate reaches the desired value.

Exposure Time
Specify how long the image sensor is exposed to light during image acquisition when Exposure Mode is Timed and Exposure 
Auto is Off.

The available features and parameters vary with different camera models. Here we only introduce part of the 
features and parameters.i

● The Exposure Mode parameter should be set to Timed, or the Exposure Time parameter is not available.

● The Exposure Auto parameter should be set to Off, or the Exposure Time parameter is not available.i
Gain Auto

Set the Automatic Gain Control (AGC) mode.

Off
Gain is controlled manually using Gain.

Once
The camera will automatically adjust gain for only once. After that, the state will automatically return to Off.

Continuous
Gain will be constantly auto-adjusted by the camera.

Gain(dB)
Set an amplification factor applied to the video signal so as to increase the brightness of the image output by the camera.

● Gain Auto should be set to Off, or the parameter will not be available.

● Increasing the gain increases all pixel values of the image.i
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Common Features

ISP
Follow the instructions below to configure the ISP parameters.

Gamma Enable
Enable the gamma correction of pixel intensity, which helps optimizing the brightness of acquired images for displaying on a 
monitor.

Gamma Selector
Specify a gamma correction mode.

User
The gamma correction value can be entered manually for the Gamma parameter as desired.

sRGB
The gamma correction value will be automatically set to approximately 0.4. This value is optimized for image display on sRGB 
monitors.

Gamma
The gamma correction value.

Sharpness Enable
If enabled, the Sharpness parameter will be available. The larger the Sharpness value, the more distinct the contours of the image 
objects will be. This is especially useful in applications where cameras must correctly identify numbers, letters or characters. 

Hue Enable
Enables/disables hue adjustment.

Hue
Hue of the image in degrees.

Saturation Enable
Enables/disables saturation adjustment.

Saturation
Saturation of the image in percent.

Balance White Auto
Balance White Auto is the 'automatic' counterpart of the manual white balance feature.

Bayer Interpolation Method
If you select Bayer as the pixel format, select Quick, Balance, or Optimal as the bayer interpolation method.

Configure White Balance (Bayer)
If the Pixel Format parameter of the camera is set to Bayer, perform the following steps to configure white balance parameters.

Before You Start
Make sure you have started acquiring image data. For details, see Acquisition and Live View in 1-Window Mode.

Steps
1. Go to the White Balance section of the Common Features tab.

2. Set Balance White Auto.

Balance White Auto
Set the mode for automatic white balancing between the color channels. Once set, the white balancing ratios are automatically 
adjusted.

Off
Set white balancing manually. See the step 3 below for details.

Once
White balancing is automatically adjusted once by the camera. Once it has converged, it automatically returns to the Off state.

Continuous
White balancing is constantly automatically adjusted by the camera.

If you select Once or Continuous, skip step 3.i
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Common Features

3. If you select Off as the value of Balance White Auto, perform the following sub-steps to configure white balance manually.

● To configure white balance manually, the Gamma Enable parameter in the feature tree should be turned off.

● To configure white balance manually, the Color Transformation Enable parameter in the feature tree should be 
turned off if the camera supports this parameter.

● To configure white balance manually, the Hue Enable parameter and the Saturation Enable parameter should be 
turned off if the camera supports the two parameters.

i

1) Click Execute of White Balance to open the White Balance Settings window.

2) Click Capture to capture an image.

3) Click draw a Region of Interest (ROI), which is shown as a green rectangle, on the original image to select the white area 
on the image.

Once you have drawn the ROI, the recommended value for the R (Red) channel, G(Green) channel, and B (Blue) channel will be 
displayed. You can manually adjust them if required.

4) Optional: Click Restore to restore the settings.

5) Click Optimize to execute optimization.

● The optimized image will be displayed on the right.

● You can view the optimized value of R (Red) channel, G (Green) channel, and B (Blue) channel at the lower right of optimized 
image.

6) Click Apply to apply the settings to the camera.

Configure White Balance (YUV/RGB/BGR)
If the Pixel Format parameter of the camera is set to YUV, RGB or BGR, you can go to the White Balance section of the Common 
Features tab to set the white balance parameters.

● If there's no white area on the original image, place a white object in front of the camera.

● You can also click to cancel the ROI settings.i

Balance White Auto
Set the mode for automatic white balancing between the color channels. Once set, the white balancing ratios are automatically 
adjusted.

Off
Set white balancing manually using Balance Ratio Selector and Balance Ratio.

Once
White balancing is automatically adjusted once by the camera. Once it has converged,it automatically returns to the Off state. 

Continuous
White balancing is constantly automatically adjusted by the camera.

Balance Ratio Selector
Selects which Balance ratio to control.

Red
Balance Ratio will be applied to the red channel.

Green
Balance Ratio will be applied to the green channel.

Blue
Balance Ratio will be applied to the blue channel.

Balance Ratio
Set the weight value (0 to 4095) for the channel selected from Balance Ratio Selector.

● White balance parameters in only available for color camera.

● The available parameters vary with different camera models.i
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GEV SCPS Packet Size   
Specify the maximum size (unit: byte) of a data packet transmitted via Ethernet. The larger the packet size, the less the Ethernet 
overhead load and hence the higher the network efficiency.

The default value (1,500 bytes), which is also the recommended value, is sufficient for most configurations.

Common Features

Transport Layer Control
The Transport Layer Control feature allows you to configure parameters related to data packet transmission. 

The available features and parameters vary with different camera models. Here we only introduce part of the 
features and parameters.i

If you increase the packet size above 1,500 bytes, make sure that Jumbo Frame of the network adapter is enabled.i
Gev SCPD   
Specify the delay (in timestamp counter units) to insert between each packet for this stream channel. This can be used as a flow-control 
mechanism if the application or the network infrastructure cannot keep up with the packets coming from the device.

Increasing the delay may reduce the amount of dropped packets at the expense of slowing the data transmission. 
As a result, the camera's frame rate may decrease.i

GEV PAUSE Frame Reception   
Controls whether incoming PAUSE Frames are handled on the given logical link.

GEV Stream Channel Selector   
Selects the stream channel to control.

LinkConfiguration   
Bootstrap register ConnectionConfig.

LinkConfigurationPreferred  
Bootstrap register ConnectionConfigDefault.

Cl Configuration  
Select a channel mode for the camera. The image outputting way varies according to different channel mode.
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On the Trigger tab, you can configure features related to the trigger of IO input and IO output.

Trigger

IO Input
On the Trigger tab, the IO Input section displays trigger related parameters, which can be used to control the acquisition of images.

The features vary with different camera models.i

For details about Action Command, see GigE Vision Action Command.i

Trigger Activation is only available when Trigger Source is set to Line 0, Line 1, Line 2 ...,Counter 0, or Anyway.i

Trigger Selector
Select the type of trigger for image acquisition.

Frame Burst Start
The trigger for starting the capture of the bursts of frames in an acquisition.

A burst of frame(s) is defined as the capture of a group of one or many frame(s) within an acquisition.

Trigger Mode
Controls if the selected trigger is active.

Off
Disable the selected trigger.

On
Enable the selected trigger.

Trigger Source
Specify the internal signal or physical input Line as the trigger source.

Software
Specify that the trigger source will be generated by the software when you execute the TriggerSoftware command or set Enable 
Auto Trigger switch to on.

Line 0, Line 1, Line 2 ...
Specify the selected physical line (or pin) and associated I/O control block as the external source for the trigger signal.

Counter 0
Specify the selected Counter signal as the internal source for the trigger.

Action 1
Specify the selected Action Command as the internal source for the trigger.

Anyway
All the above-mentioned trigger source types (Software, Line 0, Line 1, Line 2 ..., Counter 0, and Action 1will be used as the 
source for the trigger.

Trigger Activation
Specify which signal transition activates the trigger.

Rising Edge
Specify that the trigger is considered valid on the rising edge of the source signal.

Falling Edge
Specify that the trigger is considered valid on the falling edge of the source signal.

Level High
Specify that the trigger is considered valid if the level of the source signal is high.

Level Low
Specify that the trigger is considered valid if the level of the source signal is low.

Trigger Delay
Specify the delay in microseconds (μs) to apply after the trigger reception before activating it.

Auto Trigger Time
Specify the interval in milliseconds (ms) to generate the trigger signal automatically.

● Auto Trigger Time is only available when you set Software as the Trigger Source.

● Auto Trigger Time is only effective when the Enable Auto Trigger switch is set to on.i
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Trigger

The parameter is only available when you set Software as the Trigger Source.i

Enable Auto Trigger
Enable the software to generate the trigger signal automatically.

Trigger Software
Click Execute to execute the TriggerSoftware command so as to generate the trigger signal.

PostDivider
Sets the PostDivider value for the PostDivider sub-module.

PreDivider
Sets the pre-divider value for the pre-divider sub-module.

Encoder Selector
Selects which Encoder to configure.

Encoder Source A/B
Selects the input line as signal source for the shaft encoder module.

Encoder Trigger Mode
This enumeration value selects the circumstances for the shaft encoder module to output trigger signals.

Encoder Counter Mode
Selects the counting mode of the tick counter of the shaft encoder module.

Encoder Counter
This integer value (read only) indicates the current value of the tick counter of the shaft encoder module.

Encoder Counter Max
This integer value sets the maximum value for the tick counter of the shaft encoder module.

Encoder Counter Reset
This command resets the tick counter count of the shaft encoder module to 0.

Encoder Max Reverse Counter
This integer value sets the maximum value for the reverse counter of the shaft encoder module.

Encoder Reverse Counter Reset
This command resets the reverse counter of the shaft encoder module to 0 and informs the module that the current direction of 
conveyor movement is forward. Reset must be carried out before the first conveyor movement in the forward direction.



Getting Start Guide with iDatum 36

Trigger

IO Output
On the Trigger tab, the IO Output section provides parameters which allow you to control the general input and output signals of 
the camera.

The displayed features vary with different camera models. This topic only introduces common IO Output features.i
Line Selector

Selects the physical line (or pin) of the external device connector or the virtual line of the Transport Layer to configure its 
parameters such as line mode.

Line Mode
Control if the selected line is used to input signals, output signals, or control lights.

Input
Use the selected line to input signals.

Line Debouncer Time
Set a debouncer time (range: 0 to 1000000, unit: μs) to filter out invalid short signals (i.e.,contact bouncing signals). Once you 
set a debouncer time, signals that do not last longer than the time will be ignored.

Strobe
Used the selected line to output signals to control light source of the camera.

Line Source
Exposure Start Active
If the exposure starts, the output signals for controlling the light will be triggered.

Acquisition Start Active
If acquisition starts, the output signal for controlling the light will be triggered.

Acquisition Stop Active
If acquisition stops, the output signal for controlling the light will be triggered.

Frame Burst Start Active
If the burst of a frame starts, the output signal for controlling the light will be triggered.

Frame Burst Stop Active
If the burst of a frame stops, the output signal for controlling the light will be triggered.

Soft Trigger Active
Trigger the output signal for controlling the light via the Software.

Hard Trigger Active
Trigger the output signal for controlling the light via the camera.

Counter Active
Trigger the output signal for controlling the light by the counter.

Timer Active
Trigger the output signal for controlling the light by the timer.

Strobe Enable
Enable the strobe mode.

Strobe Line Duration
Set the time duration (unit: μs) of the output signal for controlling the light.

Strobe Line Delay
Set the delay time (unit: μs) for triggering the output signal for controlling the light if the events defined in Line Source occur.

Strobe Line Pre Delay
Set the pre delay time (unit: μs) for triggering the output signal for controlling the light if the events defined in Line Source occur.
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Trigger

Encoder Control
For line scan cameras, if the trigger mode is set to line trigger, you can configure the encoder signal sources for triggering.

Encoder Selector
Select an encoder.

Encoder Source A/B
Set the signal source A and B respectively for the encoder.

It is recommended that you select different sources for A and B. If they are set to the same source, the shaft 
encoder will not output signal.i

Encoder Trigger Mode
Select the triggering direction of the signal sources from Any Direction, Forward Only, and Backward Only.

Encoder Counter Mode
Select a counting mode for the counter of the encoder from Ignore Direction, Follow Direction, and Backward Direction.

Encoder Counter
(Read Only) Displays the number of triggered signals counted by the encoder counter in real time.

Encoder Counter Max
Set the maximum value allowed for the encoder counter.

When the value displayed by Encoder Counter reaches the set maximum value during counting, Encoder Counter will be 
automatically cleared when the next valid signal is received, and the counting will start again.Encoder Counter can also be cleared 
manually via Encoder Counter Reset.

Encoder Counter Reset
Click Execute to reset Encoder Counter to 0.

Encoder Max Reverse Counter
Set the maximum value allowed for the reverse counter of the encoder to allow the camera to not output images until the object 
returns to the starting position in the forward direction.

Encoder Reverse Counter Reset
Click Execute to reset the count of the reverse counter to 0.

Frequency Converter Control
For line scan cameras, if the trigger mode is set to frame trigger or line trigger, you can configure the parameters for converting the 
frequencies of hard triggering signals or shaft encoder signals to the frame trigger or line trigger frequencies required by the camera.

Input Source
Select an input source for the frequency conversion.

N/A indicates no signal source is selected.i
PreDivider

Set a positive integer for the PreDivider.

Signal of the input source is first processed by the PreDivider, which divides the signal frequency by the set integer and then sends 
the processed signal to the Multiplier.

Signals with frequencies above 100 kHz must be processed by the PreDivider, because the Multiplier can only 
accept signals within the range of 10 to 100 kHz. Periodic jitter of the encoder signal is accepted.i

Multiplier
Set a positive integer for the Multiplier.

The Multiplier multiplies the frequency of the signal received from the PreDivider by the set integer, and then sends the processed 
signal to the PostDivider.

PostDivider
Set a positive integer for the PostDivider.

The PostDivider divides the frequency of the signal received from the Multiplier by the set integer. The resulting signal will be used 
by the camera as the trigger signal.
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Advanced Features

On the Advanced Features tab, you can configure features related to ROI feature, AOI feature, embedded information, color 
correction matrix settings, LUT (Look-up Table) feature, and other features.

Draw ROI
After ROI (Region of Interest) being configured, the system only acquires the image data within the ROI, which improves the 
acquisition efficiency.

Before You Start
Make sure you have exited the AOI drawing mode.

Steps

You can also go to Feature Tree → Image Format Control and then configure Width,Height, Offset X, and Offset Y 
to set ROI. The value of Width plus the value of Offset X should not be larger than the Max. Width, and the value 
of Height plus the value of Offset Y should not be larger than the Max. Height.

i
1. Click or double-click the camera to connect it with the Software.

2. Select the connected camera.

3. Click Advanced Features on the Feature List panel.

4. Click to display the ROI features.

5. Select an ROI from the ROI Selector drop-down list.

6. Select pixel format from the Pixel Format drop-down list.

7. Draw ROI.

– Click ReDraw, and then drag the cursor on the image to draw ROI (displayed as a blue rectangle).

– Click Edit, and then the ROI (displayed as a blue rectangle) will cover the whole image.

You can move the cursor to the edge of the rectangle, and then drag the two-way arrow to adjust the ROI.

8. Perform one of the following operations.

– Manually adjust the OffsetX, OffsetY, width of ROI, and height of ROI.

– Move the cursor to the edge of the blue rectangle, and then drag the two-way arrow to adjust the size of the ROI.

9. Optional: Adjust the position of the ROI.

– Click to move the ROI to the center of the Live View window. 

– Hover the cursor onto the ROI until the cursor turns into a hand icon and then drag the ROI to adjust its position.

10.Finnish drawing.

– Right-click the image and then click Finish.

– Click

The image resolution will be lower after setting ROI.i
Only the selected ROI will be displayed.

11. Optional: Click Restore Max. ROI to restore the image to the original size.

The image resolution will also be restored to the original state.i
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Advanced Features

Configure AOI
AOI, which is short for Auto Function ROI, is the ROI that provides certain automatic functions.

Perform the following steps to configure AOI.

Steps
1. Draw an AOI.

Drawing the AOI is similar to drawing ROI. You can refer to Draw ROI for details.i
2. Select the AOI type.

– Select AOI1 from AOI Selector, and then enable AOI Usage Intensity to set the exposure of the whole image to the same as 
the AOI exposure.

– Select AOI2 from AOI Selector, and then enable AOI Usage White Balance to set the white balance of the whole image to the 
same as the AOI white balance.

AOI2 is only available for color camera.i

Embedded Information
The Embedded Information feature allows you to embed data into the acquired images.

You can select data to embed them into the acquired images. The selected ones will be displayed on the Embedded Information 
window, you can view the data details on it.

● For details about viewing details of the embedded information on the Embedded Information window, see View 
Embedded Information.

● The types of data that can be embedded into the acquired images include Timastamp, Gain, Exposure, Brightness, 
White Balance, Frame Number, Triggering Number, Line Input/Output, and ROI.

White Balance data is only available for color camera.

i

Embedding data into acquired images is realized in two ways, i.e., through the Contrastech private protocol, or through the Chunk 
Data Control feature. If the camera supports the Chunk Data Control feature, the way through the Chunk Data Control feature shall 
prevail;

If the camera doesn't support the Chunk Data Control feature, embedding data is realized through the Contrastech private protocol.

● If the camera supports the Chunk Data Control feature, you should check Chunk Mode Active first, and then select data.

● If the camera doesn't support the Chunk Data Control feature, select data directly.
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Advanced Features

Color Correction Matrix Settings
You can define multiplicative factors in Color Correction Matrix (CCM) to transform color contributions (e.g., R, G, B or B, G, R ) of 
each incoming color pixel to corrected values, so as to enhance color fidelity of the images output by your camera. This is useful in 
areas where high color fidelity is required, such as microscopy.

Before You Start
Make sure the camera supports Color Transformation Control or Bayer format. Otherwise CCM settings will be unavailable.

Steps
1. Connect the camera to the Software, and then select it.

2. Go to the feature tree panel, and then select the Advanced Features tab.

3. In the CCM settings area, turn on CCM Enable.

4. Set multiplicative factors in the 9 fields below (see the figure below), which represent a 3 × 3 color correction matrix.

Valid value range of the multiplicative factor is from - 4 to 4.i
Example

Take RGB to RGB transformation for an example. In this case, multiplicative factors (from a11 to a33) marked in the figure 
below represent the following meanings.

a11
Red contribution to the red pixel.

a12
Green contribution to the red pixel.

a13
Blue contribution to the red pixel.

a21
Red contribution to the green pixel.

a22
Green contribution to the green pixel.

a23
Blue contribution to the green pixel.

a31
Red contribution to the blue pixel.

a32
Green contribution to the blue pixel.

a33
Blue contribution to the blue pixel.
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Advanced Features

Configure LUT
LUT is short for Look-up Table, which is basically an array. It provides a mathematically precise and fast way to replace the pixel values 
in the image by values defined by you. For example, you can create a "luminance look-up table" to replace the luminance value (or 
gray value) in the images to optimize the luminance of the images. The Software sorts out the frequently-used LUT parameters in the 
LUT section on the Image Processing tab.

Before You Start
Make sure you have set LUT Index and LUT Value in the feature tree.

LUT Index
Set a pixel value that you want to replace with a new value.

LUT Value
Set a new pixel value to replace the value you set in LUT Index.

Steps
1. Connect the camera to the Software and select the camera.

2. Go to the Advanced Features tab on the Feature List panel.

3. Click to display the LUT parameters.

4. Select a value (e.g., Luminance, Red, Green, or Blue) from LUT Selector to set the LUT type.

Luminance
Luminance LUT, i.e., the look-up table for optimizing luminance of the images.

Red
Red LUT, i.e., the look-up table for optimizing red value of the images.

Green
Green LUT, i.e., the look-up table for optimizing the green value of the images.

Blue
Blue LUT, i.e., the look-up table for optimizing the blue value of the images.

Other Features
Configure the following parameters according to your need.

Binning Selector
Selects which binning engine is controlled by the BinningHorizontal and BinningVertical features.

Binning Horizontal/Vertical
Number of horizontal/vertical pixels to combine together.

Decimation Horizontal/Vertical
Horizontal/vertical sub-sampling of the image.

Shading Selector
Selects the mode of shading correction.

Activate Shading
Activates the selected shading set.

NUC Enable
Enable the FPNC and PRNUC Control

PRNUC User Enable
Enable PRNUC user table

Event Selector
Selects which Event to signal at the host application.

Event Notification
This enumeration sets the type of a notification that will be sent to the host application for the selected event.

The available LUT types vary with different camera models.i
5. Turn on LUT Enable to enable LUT.

6. Select the type of line (Fold Line, Curve, Free Line, and Adaptive) to be displayed on the LUT graph.

● Each point on the line defines the Output value in corresponding to an Input value. The Input values represent 
the pixel values that need to be replaced, while the Output values represent the new pixel values that will replace 
the old ones.
● By default, the maximum Input value for the line is the value you set for LUT Index, and the maximum Output 
value for the line is the value you set for LUT Value.

i
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Advanced Features

7. Optional: Adjust the line on the LUT graph.

– For Fold Line and Curve, drag each node to edit the line.

– For Free Line, click or drag the cursor on the graph to edit the line.

– For Adaptive, specify gamma, contrast, and luminance values and the LUT graph will be automatically generated.

You can zoom in the LUT graph for higher precision by scrolling up the mouse wheel on the graph.i
8. Click Execute of Apply to Camera to apply the LUT settings to the camera.

9. Optional: Perform the following operations.

Load LUT Settings from Camera
Click Execute of Load from Camera to load LUT settings from the camera to the chart.

Export LUT Settings from File
Click Execute of Export to File to export the LUT settings to the local PC as a TXT file.

Import LUT Settings from File
Click Execute of Import from File to import the LUT settings from a TXT file.

Clear Line Settings
Click Execute of Clear to clear the line settings of the chart.
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Temperature Window

Only the fourth tab of the camera feature configuration pane of infrared cameras is the Temperature Window tab. 
For other cameras, the fourth tab is Advanced Features (see Advanced Features).i

The Temperature Window allows you to view temperature values and variation curves of temperature screening regions.

Import/Export Features of a Single Device

You can export the feature configurations of the selected device as an MFS or HCF file to the local PC, and import the file from the 
local PC to the selected devices to fast configure all its features without the inconvenience of configuring its features one by one.

Before You Start
Connect the camera or frame grabber to the Software and make sure its image data acquisition has been stopped.

To export features of a selected camera, you only need to click . If you need to import features of a single camera, perform the 
following steps.

The number of windows displayed on this tab depends on the display parameter configurations. Up to 4 
temperature value windows and 1 temperature curve window are allowed to be displayed here.i

● The read-only feature cannot be exported.

● The exported information doesn't contain camera IP address, MAC address, serial No., and user ID.i

When configuring the temperature screening parameters, you can choose whether to display on the Temperature Window the 
temperature values and curves of the temperature screening regions you have drawn. The value shows the real-time statistics of the

corresponding region; the curve shows the temperature variation of the corresponding region over the last 12 hours.

Refer to Temperature Screening Configuration for details about how to draw regions for temperature screening and how to 
configure the relevant parameters.

Steps

1. Click and then select a file from the local PC.

● For cameras, select an MFS file; for frame grabbers, select an HCF file.

● Only when the model of the source camera or frame grabber is same with that of the target camera or frame 
grabber can the file be imported.

i
2. Click Import to import the feature configurations.
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Import/Export Features of Multiple Devices

● Up to 20 cameras can be selected.

● You can only select the cameras of Free status.i

● The progress and results of the operation are displayed on the Operation Status column.

● You can view the exception information and error code if importing features to a specific camera fails.i

The exported MFS file is named as "camera model_serial number" by default and the name cannot be edited by 
default. Example: LEO2 1440S-65gm_00603654120.i

5. Export or import the features of the selected cameras.

– Click Export to export the features of the selected cameras as a MFS file.

– Click Import to select a MFS file so as to import the features saved in the file to the selected cameras.

On Import/Export Features window, all the GigE Vision cameras on the same local subnet with the PC on which the Software runs, 
the connected USB3 Vision camera, the connected Camera Link cameras will be displayed automatically. You can select camera(s)

and then export their feature configurations to the local PC as MFS files, or import MFS files to fast load the feature configurations 
to the camera(s).

Steps

The Software does not support importing or exporting features of multiple frame grabbers.i
1. Open the Import/Export Features window in one of the following two ways.

– Click Tool → Import/Export Features.

– Click Import_Export_Features in the installation directory of the Software.

2. Optional: Click to select the to-be-displayed information (model name, device user ID, MAC address, etc.).

3. Select an interface from the interface list on the left.

4. Select cameras under the selected interface.



45 Getting Start Guide with iDatum

File Access

The File Access feature allows you to export the User Set or DPC (Defective Pixel Correction) file of a connected device to the local 
PC as a binary file, or import a binary file from the local PC to a connected device.

● The feature should be supported by the camera.

● The File Access feature is available to use only when the camera is idle, i.e., not acquiring images.

● For details about User Set, see User Set Control .
i

Import User Set
You can import a binary file from the local PC to the User Set of the camera.

Steps
1. Connect the camera to the Software.

2. Click to open the File Access window.

3. Select a User Set (User Set1, User Set2, or User Set3) or DPC from the drop-down list.

4. Click Import to select the corresponding binary file and import it.

● DPC can only be imported to the same camera, while User Set can only be imported to the cameras of the same 
model.

● The DPC will be imported and be effective directly. While for User Set, you should load the User Set to make it 
effective (see Step 5).

i
5. If you select a User Set in step 3, load the User Set to make it effective.

1) Click Feature Tree.

2) Click to display the features under User Set Control.

3) Select a User Set from User Set Selector.

4) Click Execute to execute the User Set Load command to load the selected User Set.

Export User Set
Perform the following task to export User Set to the local PC.

Before You Start
Save the current camera settings to a specific User Set. See User Set Control for details.

Steps
1. Connect the camera to the Software.

2. Click to open the File Access window.

3. Select a User Set or DPC from the drop-down list.

4. Click Export to export the User Set to the PC as a binary file.

● The file format is mfa by default.

● The name of the exported file is "Camera Model_Camera Serial Number_User Set Name" by default. Example:  
LEO2 1440S-65gm_00603654120_UserSet2.mfa

i
A prompt will appear when the Use Set is exported.

5. Optional: Click View to go to the directory of the exported file.
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User Set Control

A User Set is a group of parameter values with all the settings needed to control the camera. In other words, each User Set includes 
the values of almost all camera parameters. You can globally control the camera settings by saving and loading User Set.

If you have configured the camera parameters as required, you can save them as a User Set.You can load your own User Set to 
restore the camera to the saved group of parameter values with a minimum of configuration effort.

User Set Description
Click or double-click a camera to connect it to the Software, and then click to open the User Set Control window.

Start Settings
Click a user set to activate the camera settings in the user set. You need to restart the camera afterward.

Device Restart
Click Restart to reboot the camera in order to apply the new camera settings.

Loading user sets is only available when the camera is idle, i.e., not in acquisition.i

Difference between Default User Set and Customizable User Set

Default Read-only factory settings. In other words, the default startup settings on the camera.

User Set 1, 2, 3...

User sets that can save your own camera settings.
Initially, customizable user sets contain the same parameter values as the Default user set. You can 
save your own camera settings to these user sets to suit your applications.
 

Number of user sets vary with different camera models.i
User Set Operations
Do the following to save, load, and activate user sets.

Save Settings
Click a user set to save the current camera parameters to the user set.

Load Settings
Click a user set to load the settings in the user set to the camera. When a user set is loaded, it overwrites the current camera settings 
but does not take effect immediately. 

You need to activate the settings in Start Settings and then restart the camera.

You need to reconnect to the camera after rebooting. You might need to refresh the camera list to show the camera 
after a reboot.i
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Acquisition and Live View

Acquisition and Live View in 1-Window Mode

You can view the live video of a specific camera or multiple cameras in 1-window mode.

Steps
1. Connect camera(s) to the Client.

2. Start acquiring image data.

– If only one camera is connected, click to start acquiring image data from the camera.

– If multiple cameras are connected, click to start acquiring image data from the connected cameras simultaneously.

If you are acquiring image data from a single camera, the live view of the camera will be displayed; If multiple cameras,the live 
view of the currently selected camera will be displayed.

3. Optional: Perform the following operations if required.

Stop/Resume Live View

Click to stop live view, and click to resume live view 

You can start image data acquisition and view the live video of a single machine vision camera or the live video of multiple machine 
vision cameras simultaneously. And during the live view, you can determine the optimal image quality and perform operations such 
as recording video, capturing pictures, and zooming in or out.

Acquisition and live view are two different concepts:

Acquisition
The process in which the camera acquires image data.

Live View (or Live Video)
The display of live images by rendering the image data acquired by the camera.

After live view being stopped, acquisition still goes on.i
Switch Camera for Live View
If you are acquiring image data from multiple cameras, you can double-click the connected camera on the device list to switch

camera for live view.

Display Thumbnail View

Click at the lower-right of the image to display the thumbnail view.

When you zoom in the live view image, an orange rectangle,which represents the zoomed-in part of the original image, will

display on the thumbnail view. You can drag the rectangle to view details of different parts of the original image.

See More Functions for details about image zoom.i
4. Stop acquisition.

– Click to stop acquiring image data from the currently selected camera.

– Click to batch stop acquiring image data from the connected cameras.
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Acquisition and Live View in Multiple-Window Mode

You can view the live view of a specific camera or the live videos of multiple cameras in multiple-window mode. In this mode, you 
can view the live videos of multiple cameras simultaneously.

Steps

You can acquire image data from up to 16 cameras simultaneously.i
1. Connect camera(s) to the Software.

2. Click , and then select a multiple-division mode.

3. Drag the connected camera(s) from the device list to the display window(s) to view the camera’s live video.

4. Start acquiring image data.

– If only one camera is connected, click to start acquiring image data from the camera.

– If multiple cameras are connected, click to start acquiring image data from the connected cameras simultaneously.

5. Optional: Perform the following operations after starting acquisition.

Adjust Window Position
Drag the title bar of a display window under live view to adjust its position.

Stop/Resume Live View

Move the cursor to the lower part of the live video image, and then click on the appeared toolbar to stop live view of the

selected camera. And click to resume live view 

After live view being stopped, acquisition still goes on.i
Switch to 1-Window Mode
Double-click the live video image or click the Maximize button to switch to 1-window mode.

● You can double-click the live video image again or click the Minimize button to restore the window division 
mode to multiple-window mode.

● When switching from multiple-window mode to 1-window mode, the live video of the first live-viewed camera 
in multiple-window mode will be displayed. You can drag the camera from the device list to the display window 
or double-click to camera to switch camera for live view.

i

6. Stop acquiring image data.

– Move the cursor to the lower part of the live video image, and then click on the appearing toolbar to stop acquisition of the 
selected camera.

– Click to batch stop acquisition.
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View Local Image and Video

If the image or video is in RAW format, its name should conform to the following rules:

○ For image: XXX_w frame width value_h frame height value_p pixel format.raw (e.g., image_w1280_h728_
pMono8.raw).

○ For video: XXX_w frame width value_h frame height value_p pixel format_f frame rate value.raw for video (e.g., 
video_w1280_h728_ pMono8_f30.raw).

i

You can view local images and videos on the Software. The supported image formats include BMP, JPG, PNG, TIFF, and RAW. For 
videos, only the videos of RAW format can be played on the Software.

Before You Start
Make sure that no camera is connected to the Software.

Steps
1. Open local image or video file.

– Click File → Open Local File to select an image or video file from the local PC.

If the display window is in multi-window mode, you should have selected a window before clicking File → Open 
Local File.i

– Right-click the display window and then click Open Local File to select an image or video file from the local PC.

● If the opened local image is in BMP, JPG, PNG, or TIFF format, the image will be displayed.

● Images in Bayer10/12, Bayer 10/12 packed format are not supported.

● If the opened local image or video is in RAW format, and its file name doesn't conform to the required naming rules, the 
following window will be displayed.

2. Edit the file information, including file type, frame width, frame height, and pixel type.

3. Click OK.

The image or video will be displayed as you edited.

4. Right-click the image and then click Clear Local File to clear the local file from the Software.

Full Screen Live View

You can view live view in full screen in both 1-window mode or multiple-window mode.

In multi-window mode, you can click or Full Screen on the right-click menu to enter the full screen mode. And right-click the 
image and then click Exit Full Screen to exit full screen mode.

In 1-window mode, you can double-click the image to enter or exit the full-screen mode.
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Customize Window Division

Three default window division modes are provided in Custom Division module, i.e., 2 X 2 (4-Window), 3 X 3 (9-Window), and 4 X 4 
(16-Window). You can add the three modes to the Window Division panel, or merge (or split) windows based on the three modes.

Steps

1. Click to display the window division panel.

You can merge the selected windows only when the combination of the selected windows is of rectangle shape.i

4. Create a name for the window division mode and then click OK.

5. Select a window division mode from the Window Division drop-down list.

6. Optional: Merge or split windows.

1) Select windows.

2) Click Merge to merge the selected windows into a larger one.

2. Click Custom to open the Custom Division window.

3. Click Add to open the following window.

3) Optional: Select the merged window and then click Split to split it into the original windows.

7. Click Save.

The custom window division mode will be displayed on the window division panel.
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Capture and Recording

During live view, you can capture pictures and record video files.

Steps
1. Start live view. See Acquisition and Live View in 1-Window Mode for details.

2. Perform the following operations.

Capture and Save Picture

Click to capture a picture and save the picture to the local PC.

Start or Stop Recording

Click to start recording, and click again to stop recording.

A prompt will pop up once you finish capturing picture(s) or recording.

3. Optional: Click View on the prompt to view the picture(s) or video file(s) in the saving path.

During recording, the recording time will be displayed, and you can click at the upper-right of the display 
window to view the buffer usage, number of frame processed and frame dropped.i

Continuously Start and Stop Capturing Pictures

Click (beside ) and then click to continuously capture pictures of the live view, and click the icon again to stop capturing.

During recording, the number of the captured pictures will be displayed in real time, and you can click at the 
upper-right side of the display window to view the buffer usage, number of frame processed and frame dropped.i

You can set the saving path of the captured picture(s) and recorded video file(s). You can also set other 
parameters for recording or continuous capture. See Capture and Recording Settings for details.i
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Set Cross Line

During live view, you can display a cross line on the live view image to adjust the position of the object in the view.

Steps
1. Select a camera and start live view.

2. Click to display the cross line on the live view image.

3. Click (beside ) to open the following window.

See Acquisition and Live View in 1-Window Mode and Acquisition and Live View in Multiple-Window Mode for 
details about how to start live view. In multiple-window mode,you can set the cross line for each window.i

4. Set the parameters, such as thickness, position, and color, and the cross line will change accordingly in real time.

Window Coordinates
The cross line will be displayed on the display window.

Image Coordinates
The cross line will only be displayed on the image.

Axis X
Adjust the position of the axis X.

Axis Y
Adjust the position of the axis Y.

Position
Click Center to position the cross line to the center.

Zoom Center
If enabled, you can zoom in or zoom out the image based on the intersection point of the cross line.

For details about image zoom (or digital zoom), see More Functions.i
5. Optional: Manually adjust the cross line.

Adjust Center of the Cross Line

Hover the cursor over until the cursor turns into , and then drag to adjust the center of the cross line.

Adjust X Axis of Cross Line 

Click the X axis of the cross line until the cursor turns into , and then drag to adjust the X axis.

Adjust Y Axis of Cross Line 

Click the Y axis of the cross line until the cursor turns into ,and then drag to adjust the Y axis.

Hide Cross Line  

Click to hide the cross line.

Or right-click , and then click Hide Cross Line to hide the cross line.

Lock Cross Line  

Right-click , and then click Lock Cross Line to lock the cross line.

Locate Cross Line to the Image/Window Center  

Right-click , and then click Central to locate the cross line to the center of the image or display window.
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Configure Grid

You can configure grids on the image when acquiring image data in 1-window mode. This is especially helpful when you need to 
align objects on the image.

Steps
1. Connect a camera and then start acquisition in 1-window mode.

View Acquisition Status

During acquisition or live view, you can view the acquisition status of the camera(s), including the acquisition rate, image number, 
bandwidth, resolution, errors, packets lost and display rate, etc.

View Acquisition Status in 1-Window Mode
During acquisition or live view (in 1-Window mode), a status bar appears at the bottom of the display window to display in real time 
the acquisition status of the selected camera.

You can click in the lower-left corner to select status parameters (the selected ones will be displayed on the status bar).

For GigE Vision cameras, you can select the following status parameters: acquisition rate,image number, bandwidth, resolution, 
errors, packet lost, packets requested to resend,packets resent, display rate, location, RGB, YUV, zoom, and temperature.

For USB3 Vision cameras, you can select the following status parameters: acquisition rate,image number, bandwidth, resolution, 
errors, packet lost, display rate, location, RGB, YUV,zoom, and temperature.

For details about image acquisition in 1-window mode, see Acquisition and Live View in 1-Window Mode.i

GigE Vision Camera Acquisition Status

2. Click to display grids on the image.

3. Optional: Click (beside ) to configure grid parameters, including grid spacing and color.

Grid Spacing
Set the grid spacing value. You can set the value to 30, 60, or 90. You can also customize a value as required. The larger the value, 
the more scattered the grids will be.

USB3 Vision Camera Acquisition Status
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View Acquisition Status

View Embedded Information

During live view, you can view the information embedded into the image data, including timestamp, gain, exposure, external trigger 
number, etc.

After starting live view, you can click to open the Embedded Information window to view the embedded information.

You can click to select the information (timestamp, gain, exposure, etc.) which needs to be displayed on the window.

View Acquisition Status of Multiple Cameras Simultaneously
During live view of multiple cameras, you can click to open the Status window to view the acquisition status of these cameras. 
After that, you can click More to open the parameter panel, and then select parameters to be displayed on the Status window or 
status bar.
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The Histogram functionality allows you to quickly evaluate the image quality by viewing the real-time distribution of different color 
channels (for color camera) or the real-time distribution of gray values in the images (for mono camera).

View Histogram

The following text only takes viewing the histogram data of color camera for an example.i
Start acquisition and then click to open the Histogram window.

View Mode
Set the view modes, including Histogram, Line Profile and Column Profile.

Histogram
Axis X
Set the value range of the axis X of the histogram.

Line Profile
Location
Display the coordinates value of your cursor when you moving your cursor on the images.

Line Axis
Set the value range (0 to the horizontal resolution of the image) of the selected line which is parallel with the X axis.

Column Profile
Location

Display the coordinates value of your cursor when you moving your cursor on the images.

Column Axis
Set the value range (0 to the vertical resolution of the image) of the selected line which is parallel with the X axis.

ROI

Click and then drag the cursor on the image to draw a ROI. After that, the histogram only displays the color channel 
distribution or gray value distribution within the ROI.

You can click to cancel the ROI settings.

Logarithmic Scale
Switches between a linear and a logarithmic view of the data.

You can do the following operations if required.

Operation Description

Panning and Zooming

Panning and zooming allows you to look at specific areas of the histogram in more detail.
● Panning: Drag the cursor on the histogram to pan the histogram.
● Zooming: Move the cursor to the histogram and then scroll the mouse wheel to zoom in or 
zoom out.

Select Color Channel
for Display

If the camera is a color camera, you can check the checkbox(es) in the table, the selected color 
channel's real-time distribution will be displayed on the histogram.

Export Histogram Data Click Export to export the histogram data to the local PC.

Restore X Click Restore X to restore the coordinates if you have zoomed the histogram.
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For infrared cameras, you can perform temperature screening configurations, such as drawing different types of temperature 
screening regions and configuring the relevant parameters, including those related to screening, alarm, and display.

Draw a Region for Temperature Screening
To perform temperature screening configurations, you need to first draw regions for temperature screening.

Before You Start
Make sure you have connected an infrared camera to the Software.

Steps
1. Start the live view of the camera.

Temperature Screening Configuration

Icon Region Type Maximum No. Allowed

Point 10

Polygon 10

Line 1

Circle 1

The corresponding type of region will be added to Region List in the format "index.Type" (e.g., 0.Point). For each region type, the 
index starts with 0 and increases by one each time.

4. From the list, select a region to be drawn, click , and draw on the live view window following the instructions below.

Refer to Acquisition and Live View in 1-Window Mode and Acquisition and Live View in Multiple-Window Mode 
for details.i

For infrared cameras, you can perform temperature screening configurations, such as drawing different types of temperature 
screening regions and configuring the relevant parameters, including those related to screening, alarm, and display.

2. Click above the live view window.

3. On the top left of the configuration window, select a type of temperature screening region according to the table below.

5. For each region, select Max, Min, or Avg as needed to display the maximum value,minimum value, and mean value respectively 
for the regions drawn.

Region Type Drawing Instruction

Point Click to draw a point.

Polygon Click to draw the first vertex of the polygon, move your cursor and click again to draw 
more vertices as needed,and double-click to finish drawing.

Line Click to draw one end of the line, move your cursor, and click to draw the other one.

Circle Click, hold, and drag to draw a circle.

If needed, after a region is drawn, you can click to draw again.i

6. Optional: Select a region from the list and click to delete it if needed.

7. On the bottom left of the configuration window, click Apply Param to save your settings.

The regions you have drawn and their corresponding real-time statistics will be displayed on the live view window.

8. Optional: Click Show All to display all the regions you have drawn on the live view window. 

For points, only Avg (mean value) is available.i
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Temperature Screening Configuration

Configure Temperature Screening Parameters
Besides drawing temperature screening regions, you can also set parameters related to screening, alarm, and display on the 
Temperature Screening Region Settings window.

For the configurations to take effect, you can either click OK on the bottom right corner of the window or click 
Apply Param on the bottom left. Clicking OK will close the configuration window, whereas clicking Apply Param 
will not and you can continue with the configurations.

i
Screening
Under Screening, you can configure parameters related to the palette mode, camera basics,global screening, and expert mode.

Palette Mode
Select a palette mode for the camera from White Hot, Black Hot, etc.

Camera Parameter
Brightness
Adjust the brightness level of the live view image correspondingly. The larger the value, the brighter the image.

Gamma Enable
When enabled, you can set the gamma value correspondingly. The larger the value,the stronger the contrast.

Sharpness Enable
When enabled, you can set the sharpness level for the edges of the live view image.

Noise Reduction Enable
When enabled, the signal-to-noise ratio of the image will be boosted, so as to improve the quality of the image.

Global Screening
Set the global temperature screening parameters for the temperature screening regions.

Atmospheric Transmissivity
If a germanium glass needs to be added in front of the lens of the infrared camera, the transmittance of the germanium glass can 
be set by this parameter.

If no germanium glass is needed, you can keep this parameter as 100.i
Temp Measurement Range
Select a temperature measurement range as needed from -20℃ ~ 150℃ and 0℃ ~550℃ .

Target Distance
Set the linear distance from the target object to be measured to the device (unit: m).

Full Screen Emissivity
Set the emissivity of the target object. The emissivity value varies for different objects.

Refer to the user manual of the corresponding camera model for details.

Temp Measurement Expert Mode
When enabled, you can set the corresponding parameters for each temperature screening region respectively.

Expert Mode
Temp Region Reflect Enable
Set whether to enable reflection for the temperature screening region when there is a high-temperature object at the scene, and 
a measured object with low emissivity reflects the high-temperature object.

Temp Region Reflectance
Set whether to enable reflection for the temperature screening region when there is a high-temperature object at the scene, and 
a measured object with low emissivity reflects the high-temperature object.

Temp Region Target Distance (m)
Set the linear distance from the target object to be measured to the device (unit: m).

Temp Region Emissivity
Set the emissivity value of the target object (unit: %). The emissivity value varies for different objects. Refer to the user manual of 
the corresponding camera model for details.
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Temperature Screening Configuration

Alarm
Under Alarm, you can configure parameters related to the temperature triggered alarms for a single region or of comparing two 
regions.

Single Region Alarm
Set the alarm rule for a single temperature screening region you have drawn.

Point
For point ROIs, you can set the following parameters for conditions to trigger or restore alarms.

Point Temp
Select > or < from the drop-down list, and enter a temperature value correspondingly to set the alarm rule.

E.g., If you select > and enter 50 in the box, an alarm will be triggered when the screened temperature exceeds 50° C.

Tolerance Temp
Set the threshold for restoring alarms of the region.

E.g., If the tolerance temperature is set to 5° C while the rule for triggering alarms is set to > 50° C, alarms will be canceled 
when the screened temperature is less than or equal to 45° C.

Polygon/Line/Circle
For polygon, line, and circle ROIs, you can select a specific type of temperature statistics (Maximum, Minimum, Average, and 
Variation) and set the corresponding alarm triggering and restoring rules. The configuration process is similar to those of

setting Point Temp and Tolerance Temp for point ROIs.

E.g., If you select Maximum, >, and enter 50 in the box, an alarm will be triggered when the maximum temperature value of the 
region exceeds 50° C.

Multi-Region Alarm
Set up to four multi-region alarm rules which compare the chosen type of statistics of two temperature screening regions. Follow 
the steps below to configure a rule.

1. Select a region from the drop-down list for Region Index 1, which will be set as the reference region (i.e., the region being 
compared to).

2. Select another region from the drop-down list for Region Index 2, which will be set as the target region.

3. Choose a specific type of temperature statistics to be compared between the regions from Maximum, Minimum, Average, and 
Variation.

4. Select > or < from the second drop-down list, and enter a temperature value correspondingly to set the alarm rule.

E.g., If you select Maximum, >, and enter 10 in the box, an alarm will be triggered when the maximum temperature value of the 
target region is 10° C greater than that of the reference region.

Display
Under Display, you can configure parameters related to the display settings of the live view window and the temperature window.

Basic Display
Temperature Bar
When enabled, a temperature bar will be displayed on the right side of the live view window.

Region Information Overlay
Select a overlay mode for the region information from the followings.

● None: Disable region information overlay. No information is displayed when the camera acquires images or when the images 
are saved.

● Camera: Overlay information of the temperature screening regions to the camera, so that the information will be displayed 
when the camera acquires images and when the images are saved.

● Client: Overlay information of the temperature screening regions to the Client, so that the information will be displayed when 
the camera acquires images, but not when the images are saved.

Temperature Window
You can set up to 4 displays of temperature values and 1 display of the temperature curve to be displayed on the Temperature 
Window. For each display, you can select a temperature screening region and a type of statistics as shown below.

Refer to Temperature Window for how the display outcome looks like.
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More Functions

The Software provides additional functions for live view, such as digital zoom and image rotation.

Image Zooming
Right-click the image to open the right-click menu and then click Zoom in/Zoom out, or move the cursor to the

image and scroll the mouse wheel to zoom in or zoom out the image.

This operation is not available for local images and local videos.i

View Settings
Adjust the image quality of the live video by setting the display mode, filtering mode, vertical synchronization mode, and rendering 
engine. See View for details.

Adjust Band Width
During image data acquisition, if excessive packet losses occurs, a prompt will pop up to remind you to adjust bandwidth. In this 
case, you can tap Adjust to adjust the bandwidth so as to alleviate packet losses.

Check Image Sharpness

Click to show the sharpness indicator.

● After zooming in the live view image, you can drag the image to view more details. For details about how to 
set window division, see Customize Window Division.

● You can also use cross line for image zooming. See Set Cross Line for details.

● You can set keyboard shortcut for image zooming. See Shortcut for details.

i

● You can set keyboard shortcuts for the two operations.See Shortcut for details.

● The two operations are not supported by local images and local videos.i

You can also click to zoom in, or click to zoom out.

Fit to Window/Actual Size
Right-click the image, and then click Fit to Window to fit the size of the image to that of the display window.

Right-click the image, and then click Actual Size to restore the image to its original size (original resolution).

Image Rotation
Right-click the image and then click Rotate Left or Rotate Right to rotate the image to the left or to the right respectively.

Image rotation is not supported by local images and local videos.i

Only available for Mono-8 pixel format in 1-Window division mode.i
Export Pixel RGB Values

Click to export the RGB values of each pixel to local disk.

Only available in 1-Window division mode.i
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Tool Management

IP Configurator

The online GigE Vision cameras in the same local subnet with the PC on which the Software runs will be enumerated in the device 
list. You can configure the IP addresses and other network parameters of these cameras.

The Software provides multiples tools for the management, configuration, and maintenance of cameras, such as IP Configurator (for 
editing camera IP address),

Bandwidth Manager (for optimizing bandwidth occupied by cameras), GigE Vision Action Command (for trigger actions in multiple 
cameras simultaneously), etc.

You can view the camera status on the Status column of the device list. If the camera status is free or unreachable, you can edit its 
network parameters including IP address.

Free
The camera is available and you can edit its IP address.

In Use
The Software or other processes are accessing the camera. You need to stop the live view and disconnect the camera, or terminate 
other processes to access the camera.

Unreachable
The camera is unreachable due to one of the following two reasons:

● The network of the camera is abnormal. Check the camera network settings.

● The camera is on the same subnet with the PC on which the Software runs, but NOT in the same network segment. You should 
modify its IP address to the same network segment with the PC to make the camera available for connection and use.

You can also click to select camera information (model name, device user ID, status,etc.). The selected item will be displayed on 
the camera list.

You can move the cursor to GigE and then click to manually refresh the cameras.i
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IP Configurator

Edit IP Address of a Single Camera
You can modify the IP address of a single camera if the camera status is Free or Unreachable. 

Steps
1. Select a network interface.

2. Double-click any place in the camera row to open the Modify IP Address window.

3. Select the Static IP, DHCP, or LLA as the IP type.

Static IP
For setting the IP type as Static IP, you can modify the IP address, subnet mask, and default gateway.

DHCP
The camera is set to automatically obtain an IP address. This means that the IP address will dynamically change (within a range) 
every time the camera or computer is restarted.

LLA
The camera uses a default IP address from the link-local address block. Link-local addresses for IPv4 are defined in the address 
block 169.254.0.0/16 in CIDR notation.

In IPv6, they are assigned the address block fe80::/10.

4. Optional: Edit the camera name in Device User ID field.

5. Click OK to save the settings.

You can change the IP type only when the camera status is Free. And if you change the IP type, the camera will be 
reset to its power up state.i

Edit IP Addresses of Multiple Cameras
You can batch modify the IP addresses of multiple cameras under the same interface.

Steps
1. Select a network interface.

2. Select the cameras to be modified.

If the modified IP address conflicts with another device's IP 
address in the same local subnet, a prompt will pop up to remind 
you that IP conflict occurs. Change the IP address in this situation.

i

You can select up to 20 cameras.i
3. Click Modify IP to open the Batch Modify IP window.

4. Select Static IP, DHCP, or LLA as the IP type.

● For setting the IP type as Static IP, you can set the start IP address, subnet mask, and default gateway.

● For batch modifying static IP, you only need to configure the start IP address. The last decimal of the next IP 
address will be plus 1, and so forth (example: 192.168.1.1,192.168.1.2, 192.168.1.3...).

i
5. Click OK to save the settings.

If the modified IP address conflicts with another device's IP address in the same local subnet, a prompt will pop 
up to remind you that IP conflict occurs. Change the IP address in this situation.i
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You can update the firmwares of the cameras or frame grabbers via the Firmware Updater tool.

Steps

Firmware Updater

No more than 20 cameras or frame grabbers can be selected.i
5. Click to select an update file (DAV format) in the local PC.

The matched cameras will be selected automatically.

6. Click Update.

● During the update, do not break the connection between the devices and the PC, and ensure that the devices 
are working.

● The devices will restart automatically upon finishing the update.

● The update of frame grabbers will take effect after restarting the PC.

i

● Cameras of different types of interfaces cannot be updated at the same time.

● The firmware update file should match the camera model.i
1. Open the Firmware Updater window.

– Click Tool → Firmware Updater on the main page.Open Firmware_Updater in the installation folder.

2. Optional: The device information will be displayed on the window. You can conduct the following operations as needed.

GigE and USB Interfaces
● Select GigE or USB, and the devices connected to it will be displayed on the right.

● Select an interface under GigE or USB, and the cameras connected to the interface will be displayed on the right.

● The tool will auto refresh the cameras by default. You can also click on the right of GigE and USB to manually enumerate the 
cameras.

Camera Link Interfaces
● Select Camera Link, and the devices connected to the camera link will be displayed on the right.

● Select an interface under Camera Link, and the cameras connected to the camera link will be displayed on the right.

● The tool will not auto refresh the devices connected to camera link by default. You need to click on the right of Camera Link 
to manually enumerate the cameras.

GenTL Interfaces
Right-click GenTL and click Select CTI File. Select and open a CTI file, and the tool will enumerate the frame grabbers and cameras 
in the CTI file.

● Select GentTL, and all the frame grabbers in the CTI file will be displayed on the right.

● Select a frame grabber under GentTL, and the cameras connected to the frame grabber will be displayed on the right.

● Select a camera under GentTL, and the cameras connected to all the frame grabbers will be displayed on the right.

● The tool will not auto refresh the frame grabbers and cameras connected by the GenTL by default. You need to click on the 
right of GenTL to manually enumerate the cameras.

3. Optional: Click to select the to-be-displayed device information (model name, MAC address, firmware version, etc.).

4. Select cameras or frame grabbers to be updated.



63 Getting Start Guide with iDatum

Bandwidth Manager

Make sure that the camera(s) whose bandwidth needs to be adjusted are not in acquisition and that their Trigger mode is turned off, 
and then click Tool → Bandwidth Manager to open the Bandwidth Manager window.

You can click to select the to-be-displayed information (model name, device user ID, MAC address, etc.).

The list on the left shows the information of the GigE and USB interfaces on the PC.

● If you select All, the camera list on the right will display all cameras under the GigE interfaces and USB interfaces.

● If you select GigE, the camera list on the right will display all cameras under the GigE interfaces.

● If you select USB, the camera list on the right will display all cameras under USB interfaces.

● If you select a specific Interface, the camera list on the right will display all cameras under the selected interface.

● All GigE Vision cameras produced by Hikrobot support bandwidth adjustment by Bandwidth Manager. You can 
also adjust bandwidth for GigE Vision cameras by setting the Gev SCPS Packet Size parameter and the Gev SCPD 
parameter. For details about the two parameters, see Transport Layer Control .

● Part of the USB3 Vision cameras produced by Hikrobot support bandwidth adjustment by Bandwidth Manager. 
You can also adjust bandwidth for USB3 Vison cameras by setting the Device Link Throughput Limit Enable 
parameter and the Device Link Throughput Limit parameter. You can inquire our technical support for details 
about how to adjust bandwidth by the two parameters if your USB3 Vision camera supports the two parameters.

i

● Manually adjust the bandwidth, and then analyze again to view the changed value of payload received, frame sent, frame 
received, etc.

Bandwidth Optimization
Based on the analysis result, you can optimize bandwidth distribution of the connected cameras in the following two ways:

● Select a GigE interface and then click Optimize Now to automatically optimize the bandwidth of the selected camera(s).

value of payload received, frame sent, frame received, etc., will be displayed.

The Bandwidth Manager allows you to adjust the bandwidth distribution of the connected cameras to avoid excessive packet losses 
so as to ensure data integrity. This is especially useful when multiple cameras use a same network interface for image acquisition.

You can click Reset Data to reset the value of the above-mentioned parameters to 0.i
Information Item Description

Payload Sent (Mbps) The payloads that the camera sent to the PC during analysis.

Payload Received (Mbps) The payloads that the camera received from the PC during analysis.

Frame Sent (fps) The frames that the camera sent to the PC during analysis.

Frame Received (fps) The frame that the camera received from the PC during analysis.

Images The number of images that the PC received from the camera during analysis.

Lost Packets The amount of packets that the PC failed to receive from the camera during analysis.

Lost Frames The amount of the frames that the PC failed to receive from the camera during analysis.

The less the payload losses and frame losses, the better the image quality would be.i

Only GigE Vision cameras support the Optimize Now function.i

Analysis before Optimization
After connecting camera(s), click Start Analysis to start analysis, and then click Stop Analysis to complete analyzing the bandwidth 
distribution of the cameras (you can also set the analysis duration to automatically stop analysis when the duration ends). And the

value of payload received, frame sent, frame received, etc., will be displayed.
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The Action Command is used to trigger actions in multiple cameras in a network simultaneously. When Action Command is 
configured, the Software can send commands across the network and have devices in a predefined group respond based on how 
they have been configured to respond to certain commands. In this way, a single command can trigger actions such as Frame Start 
in multiple cameras with a minimum of latency and configuration effort. The Action Command can be used in various scenarios 
where image fusion is required.

Before You Start
Search for the following three parameters in the feature tree and configure them for eachcamera that needs to receive commands.

GigE Vision Action Command

6. Optional: Enable Request Acknowledge to display the acknowledgment messages.

● If you enable Periodically Send, Request Acknowledge will be disabled, or vice versa.

● The default value is 1000ms, and valid value range is from 1ms to 3600000ms.
i

Parameter Description

ActionDeviceKey A kind of password which enables the camera to check the validity of the commands.

ActionGroupKey Used to specify a group of cameras to perform actions.

ActionGroupMask Used to filter out some cameras from the specified group.

● The camera should support the Action Control feature, or configuring Action Command will be unavailable.

● ActionDeviceKey, ActionGroupKey, and ActionGroupMask are all displayed in hexadecimal notation.i

Steps
1. Go to Tool → GigE Vision Action Command.

2. Select network interface(s) to set the subnet(s) that the command to be sent to.

3. Enter the device key, group key, and group mask.

Device Key
Its value should be the same with the value of the ActionDeviceKey feature.

Group Key
Its value should be the same with the ActionGroupKey feature.

Group Mask
The bitwise AND operation of the Group Mask against the ActionGroupMask feature should results in non-zero.

4. Optional: Set in Scheduled field to to enable scheduled action command.

Benchmark Camera
The value of the GevTimestampValue feature of the selected camera will be automatically acquired and be used as the start time 
point for the delay.

Delay Time
The delay time should NOT be shorter than the maximum time required to transmit the command across the network.

When the benchmark camera receives the command, all the cameras will trigger certain actions simultaneously after the specified 
delay time.

5. Optional: Enable the Software system to send commands periodically. 

1) Enable Periodically Send.

2) Enter the interval for sending the command.

7. Click Start Sending.

● If you enable Request Acknowledge, Periodically Send will be disabled, or vice versa.

● Up to 50 messages can be displayed. Once the message number exceeds 50, the earliest message will be 
automatically deleted.

i
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GigE Vision Action Command

Example
Sample Use Case

To generate slow-motion playback in stadiums for the purpose of viewing and analyzing the athlete's movement details, a group of 
camera is installed parallel to a race track (see picture below).

When the athlete passes, four cameras (subgroup 1) synchronously execute an action (capture images in this example).

As the athlete advances, the next four cameras (subgroup 2) synchronously capture images. One after the other, the subgroups 
continue in this way until the athlete has reached the end of the race track. The resulting images can be combined and processed

to generate the slow-motion playback in subsequent steps using other technology and programs.

In this sample use case, the followings should be defined.

● Use the ActionDeviceKey parameter to authorize the execution of the synchronous image acquisition. The device key should be 
configured on each camera and it should be same with the device key for the action command protocol message.

● Use the ActionGroupKey parameter to define the group of cameras in a network segment that is addressed by the action 
command (in this use case: group 1).

● Use the ActionGroupMask parameter to define the subgroups in the group of cameras that capture images synchronously (in this 
use case: subgroups 1, 2, and 3).
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You can use NIC Configurator to configure and apply the parameters of the network interface card (hereafter simplified as NIC).

You can open the NIC Configurator in the following two ways:

● Search NIC_Configurator in the Start menu of the PC and then click the found NIC_Configurator.

● In the installation directory of the Client, go to Application → Win32 or Application → Win64, and then double-click NIC_
Configurator to view the PC system information.

NIC(S)
Select the PC's NIC.

Jumbo Frame
Check the Enable checkbox to enable the Jumbo Frame function of the NIC. Jumbo Frame function can reduce the CPU usage and 
improve the data transmission efficiency. After enabling the Jumbo Frame function, the Jumbo Frame value will be set to 9 KB or 
9014 Bytes automatically.

Receive Buffers
Set the size of Receive Buffers. Increasing the Receive Buffer size improves receiving performance while costs more system memory.

Transmit Buffers
Set the size of Transmit Buffers. Increasing the Transmit Buffer size improves data transmission performance while costs more system 
memory.

NIC Properties
Click Open to open the properties page of the selected NIC. You can view and edit the NIC properties if needed. 

Internet Protocol Properties
Click Open to open the properties page of the internet protocol. You can view and edit the IP address and other network parameters 
of the current PC. 

Batch Settings
Apply the settings of the above parameters to all the NIC. 

NIC Configurator

You can use Driver Manager to view the status (installed or uninstalled), and install or uninstall the GigE Vision driver and USB Vision 
driver.

You can open the Driver Manger in the following ways:

● Search Driver_Installation_Tool in the Start menu of the PC, and then click the found Driver_Installation_Tool to open the Driver 
Manager.

● In the installation directory of the Client, go to Application → Win32 or Application → Win64,and then double-click Driver_
Installation_Tool to open the Driver Manager.

Driver Manager
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You can use the Diagnostic Tool to diagnose the running environment and the secondary development environment, and then 
optimize the environments basing on the detected exceptions.

Diagnose the running environment first (see Diagnose Running Environment), and then optimize the running environment (see 
Optimize Environment, and finally check and resolve specific exception(s) (see Check and Resolve a Specific Exception).

Diagnose Running Environment
You can search Diagnostic_Tool.exe in the Start menu, and then click the found Diagnostic_Tool.exe to run the Diagnostic Tool.

You can select SDK Diagnosis, Driver Diagnosis, or (and) System Diagnosis, and then click Diagnose to start diagnosing.

SDK Diagnosis
Diagnose the secondary development environment.

Driver Diagnosis, System Diagnosis
Diagnose the iDatum running environment.

While diagnosing, you can also click the tool(s) at the bottom of the page to help the diagnostics work.

Log Viewer
View the SDK logs. For details, see SDK Logs.

Driver Manager
Manage the GigE Vision driver and the USB driver. For details, see Driver Manager.

NIC Configurator
Configure the PC's network adapter parameters. For details, seeNIC Configurator.

When diagnosis ends, the exception number of each type of the diagnosis results (Serious, Fatal,or Normal) will be displayed, and all 
the exceptions will be displayed by different categories. You can view and handle each one of them respectively.

Diagnostic Tool

Result Type Description

Fatal The exceptions that may cause fatal problems such as system crash or secondary development failure.

Serious The exceptions that may cause serious problems such as streaming failure.

Normal The item is normal and is marked with .

The following table shows the description of each type of diagnosis results.
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Optimize Environment
If exception(s) are detected after diagnosis, you can click Start Optimization to optimize the iDatum running environment and the 
secondary development environment.

Diagnostic Tool

After optimization, you may still need to resolve some exceptions manually. Take network line rate exception (lower 
than 1Gbps) for an example, you need to manually check if the NIC, network or the switch is abnormal.i

Check and Resolve a Specific Exception
The Diagnostic Tool can detect various types of exceptions, including the exception that SDK files are copied to multiple saving 
paths, environment variable exception, driver exception, USB controller exception, Jumbo Frame exception, and network line rate 
exception.

● For the exception that SDK files are copied to multiple saving paths, you can click Check, and then delete a specific SDK file or 
click Clear All to clear all the SDK files.

● For environment variable exception, you can click Repair to repair the detected problems.

If no exception is detected, you can also click Check to view the variable information such as variable name and status.

● For driver exception, you can click Check to view the driver information such as the driver version and driver's latest update time.

● For USB controller exception, you can click Check to view the USB controller information, such as driver key, device ID, and 
vendor ID.

● For Jumbo Frame exception, you can click Check to view whether Jumbo Frame of the network adapter is enabled or not and the 
Jumbo Frame value (if enabled).

To ensure data transmission efficiency, make sure that Jumbo Frame is enabled.i
● For network line rate exception, you can click View Solution to view the exception details and solution.

The Client provides a tool for viewing the PC system information, such as CPU, CPU core number,operating system, screen 
resolution, etc.

You can open the tool in the following two ways:

● Search System_Info in the Start Menu of the PC, and then click the found System-Info to view the PC system information.

● In the installation directory of the Client, go to Application → Win32 or Application → Win64,and then double-click System Info 
to view the PC system information.

View PC System Information
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Logs

Software Logs

You can view the logs about operations and progresses on the Software.

Click to open the Log Information window.

You can view the information such as importance level, date, content, and source.

You can click Clear Logs to clear all the displayed logs.

You view both logs about progresses and operations on the Client, and the SDK (Software Development Kit) logs.

SDK Logs

Via the Log Viewer tool, you can view the SDK logs of MvCameraControl.dll, MVGigEVisionSDK.dll,MvUsb3vTL.dll, MvCamLVision.dll, 
and other DLL(s) if required. You can also configure log settings such as the maximum number of the displayed SDK logs.

View SDK Logs
You can view the SDK logs of the Client. Three types of SDK logs are available, i.e., error, warning,and information. Each log contains 
the information including log type, log time, log content,process name, etc.

Click Tool → Log Viewer to open the Log Viewer window.

The following table shows the descriptions of the three types of SDK logs.

Log Type Description

Error Errors occurred on the Client.

Warning The warning information sent by the Client when precondition error occurs.

Information The information about operations.

You can perform the following operations.

Operation Description

Export All SDK Logs Right-click the log list and then click Export All Logs.

Export Selected SDK 
Logs

Press and hold the Shift key and left-click the mouse to select multiple SDK logs continuously, 
and then right-click the log list and click Export Selected Logs.
Or press and hold the Ctrl key and left-click the mouse to select multiple SDK logs, and then 
right-click the log list and click Export Selected Logs.
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The range of maximum displayed logs is from 1 to 100,000 (default value: 1000).i

SDK Logs

Operation Description

Search Logs

Enter the keywords to search logs.

Refresh Logs Click Refresh to refresh logs.

Copy All SDK Logs Right-click the log list and then click Copy All Logs.

Copy Selected SDK 
Logs

Press and hold the Shift key and left-click the mouse to select multiple SDK logs continuously, and then 
right-click the log list and click Copy Selected Logs.
Or press and hold the Ctrl key and left-click the mouse to select multiple SDK logs, and then right-click 
the log list and click Copy Selected Logs.

Clear All SDK Logs Right-click the log list ant then click Clear Logs

Stick to the Top or Not Click to stick the Log Viewer window to the top, click to undo.

Select Displayed 
Information Click to select the to-be-displayed information (time,type, content, source, etc.).

Rank Logs Click the Time table header to rank the logs by time (descending order or ascending order).

You can only search by the keywords of the content of the log. Searching by the keywords 
of log type, log time, or log source is not supported.i

Configure Logs
Configure log settings of cameras and frame grabbers.

Camera Logs
Select Camera in LogSource, and you can click More on the top of the log viewer window to

configure log view settings and log service settings of cameras.

Log View Settings
You can set the DLL(s) to be displayed on Log Viewer.

Select DLL(s)
Check the checkbox(es) to select DLL(s). You can only select MvCameraControl.dll,MVGigEVisionSDK.dll, MvUsb3vTL.dll, and 
MvCamLVision.dll.

The range of the time interval is from 100 to 1000,000 (default value: 1000).i
Log Service Settings

Max. Storage Size
Set the maximum storage size (unit: MB) for the SDK logs (default value: 10).

Storage Type
The selected type of SDK logs will be stored.

MvCameraControl Logs about operations on the Software will be displayed (if exist).

MVGigEVisionSDK Click Refresh to refresh logs.

MvUsb3vTL Logs about the Software accessing USB3 Vision cameras will be displayed (if exist).

MvCamLVision Logs about the Software accessing Camera Link cameras will be displayed (if exist).

Add DLL
Enter the name of a DLL in the input box, and then click Add.

Max. Displayed Logs
Set the maximum number of displayed logs.

Interval for Update (ms)
Set the time interval (unit: ms) for upgrading the log list.
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SDK Logs

Frame Grabber Logs
Select FrameGrabber in LogSource, and you can click More on the top of the log viewer window to configure log settings of frame 
grabbers.

Max. Displayed Logs
Set the maximum number of displayed logs.

The range of maximum displayed logs is from 1 to 100,000 (default value: 1000).i

The range of the time interval is from 100 to 1000,000 (default value: 1000).i

Interval for Update (ms)
Set the time interval (unit: ms) for upgrading the log list.
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Error Code List

Error Code

The error codes of the Software and machine vision camera SDK are as the following.

Software Error Code Camera SDK Error Code Description

Normal Code Description

0x00000000 0x00000000 Succeeded. No error.

General error codes.

0x90006100 0x80000000 Incorrect or invalid handle.

0x90006101 0x80000001 The function is not supported.

0x90006102 0x80000002 No more cache can be stored.

0x90006103 0x80000003 Function calling order error.

0x90006104 0x80000004 Incorrect parameter.

0x90006105 0x80000006 Applying for resource failed.

0x90006106 0x80000007 No data.

0x90006107 0x80000008 Not prepared, or the running environment has changed.

0x90006108 0x80000009 Versions mismatch.

0x90006109 0x8000000A No enough storage.

0x9000610A 0x8000000B Abnormal image. Package missing may cause the abnormality.

0x9000610B 0x8000000C Importing DLL dynamically failed.

0x9000610C 0x8000000D No cache can be output.

0x9000610E 0x8000000E Incorrect file path.

0x900061FF 0x800000FF Unknown error.

Error codes of GenI cameras.

0x90006200 0x80000100 General error.

0x90006201 0x80000101 Invalid parameters.

0x90006202 0x80000102 The value exceeds the range.

0x90006203 0x80000103 Incorrect node property.

0x90006204 0x80000104 Running environment error.

0x90006205 0x80000105 Logic error.

0x90006206 0x80000106 Incorrect accessing condition of node.

0x90006207 0x80000107 Timeout.

0x90006208 0x80000108 Conversion exception.

0x900062FF 0x800001FF Unknown error of GenICam.

Error codes of GigE_STATUS.

0x90006300 0x80000200 Command not supported by device.

0x90006301 0x80000201 The address to be accessed does not exist.

0x90006302 0x80000202 No data can be written.

0x90006303 0x80000203 No right to access device.

0x90006304 0x80000204 Device is busy, or disconnected from the Software.

0x90006305 0x80000205 Network Package data error.

0x90006306 0x80000206 Network error.

0x90006307 0x80000221 Duplicated device IP.
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Error Code

Software Error Code Camera SDK Error Code Description

Error codes of USB_STATUS.

0x90006400 0x80000300 Reading USB error.

0x90006401 0x80000301 Error occurred when writing the USB.

0x90006402 0x80000302 Device exception.

0x90006403 0x80000303 GenICam error.

0x90006404 0x80000304 Insufficient bandwidth.

0x90006405 0x80000305 Drivers mismatch or no driver.

0x900064FF 0x800003FF Unknown USB error.

Error codes of upgrade.

0x90006500 0x80000400 Firmware versions mismatch.

0x90006501 0x80000401 Firmware languages mismatch.

0x90006502 0x80000402 Device upgrade conflict.
(The device is already being upgraded.)

0x90006503 0x80000403 Internal error occurred in the camera during upgrade.

0x900065FF 0x800004FF Unknown error during upgrade.
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FAQ
You can refer to the following information if you encounter the problems described in the following Frequently Asked Questions (FAQ).

Before checking the details of the FAQ, please check the running environment if the software cannot detect the camera, or the 
camera live view fails. You should make sure:

● The Client is running on a PC or industrial PC with gigabit network interface card.

● The network between the camera and the PC or industrial personal computer is gigabit network.

● The jumbo frame of the PC's network adapter is enabled. If not, please enable the Jumbo Frame function of the network adapter.

● The USB interface of the PC running the client software should be USB3 interface.

● The USB cable which connects the PC and the USB3 Vision camera should meet the USB3 specifications.

● The operation system is Windows XP (32-bit), Windows 7/10 (32/64-bit). Other operation system is not supported currently

If the solutions provided in the FAQ cannot solve your problem, please contact us for support. For details, see Get Support for details.

FAQs

■    No GigE Vision camera is enumerated after running the Software.
Question:

1. No GigE Vision camera is enumerated after running the Software.
2. No USB3 Vision camera is enumerated after running the Software.
3. No Camera Link camera is enumerated after running the Software.

Possible Cause：
1. The camera is not properly started.
2. The camera and cable are not connected properly.
3. The camera is not on the same LAN with the Software.(For GigE cameras)
4. The interfaces of the camera and Frame Grabber do not match. (For Camera Link cameras)
5. The Frame Grabber driver installation exception. (For Camera Link cameras)

Solution：
1/2. �Restart the camera and check whether the power connection is normal（Check if the LED indicator of the camera is in 

normal status.）,to check whether the cable connection is normal.
    Check the power supply of the camera (by checking PWR indicator) and network connection (by checking Link light in LAN 
interface).（For GigE cameras）
    Make sure that the USB 3.0 cable is connected to the USB 3.0 port behind the console. (For USB3 cameras)
    Check if the LED indicator of the camera and the indicator of the frame grabber is in normal status. (For Camera Link 
cameras)
3. �Make sure the camera is on the same LAN as the client.（For GigE cameras）
4.For Cause 4, confirm that the interfaces between the camera and Frame Grabber correspond to each other.(For Camera 
Link cameras)
5.For Cause 5，Reinstall the frame grabber. If it still not works, please contact the manufacturer of the frame grabber. (For 
Camera Link cameras)

■    The Software enumerates a camera, but fails to connect it.
Possible Cause:

1. Driver exception.
2. The camera has been connected to other programs.
3. The camera is not on the same LAN with the Software.（For GigE cameras）
4. The USB3 driver is not installed.(For USB3 cameras)

Solution：
1. �Re-plug the camera, or reinstall the camera driver.
2.Disconnect the camera from other programs, and then connect it to the Software.(For USB3 cameras)
3. �Edit the camera IP address. For details, see IP Configurator .（For GigE cameras）
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FAQs
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■   The Software enumerates a Camera Link camera, but fails to connect it.
Question:

1. Start the client and send a pop-up error message when searching for the Camera Link camera, and the error code is 6304.

Possible Cause：
Camera Link-related environment variable exceptions.

Solution：
Use diagnostic tools to detect whether environment variables are healthy. If it is abnormal, it will be repaired; If normal, please 
contact our technical for support.

■   Live view shows black image.
Possible Cause：

1. Iris of the camera lens is closed.
2. Camera exception.

Solution：
1. Open the aperture of the lens.
2. Power off and reboot the camera.

■   Acquisition works fine. But when the trigger signals are provided by external device, no image is triggered.
Possible Cause：

1.External device wiring error.
2.Certain trigger mode is not activated, or the rigger source is incorrectly selected.

Solution：
Check if the camera trigger mode of the current application scenario and the related line input is normal.
Make sure that the wiring of the external device is normal. 

■   Image flipping
Possible Cause：

The device is installed in the wrong direction.

Solution：
Image correction in iDatum: "Parameter > ImageFormatControl > ReverseX or ReverseY".

http://www.contrastech.com/en/

